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About This Guide

Revision history

Revision Date Description

C April 2014 Update in material from OpenArray® Plate Press to QuantStudio™ 12K Flex
OpenArray® Plate Press 2.0.

Purpose
The Applied Biosystems OpenArray® Digital PCR Experiments User Guide functions as a
tutorial for the scientist analyzing experimental studies performed on the Applied
Biosystems QuantStudio'" 12K Flex Real-Time PCR System with DigitalSuite™
Software.

Prerequisites

This user guide is intended for users who have been specifically trained by Life
Technologies for using the QuantStudio™" 12K Flex Instrument. Customers may start
using DigitalSuite™ Software without specifically being trained on that application.
The manufacturer is not liable for damage or injury that results from use of this
manual by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the
Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Note: First-time users of the Applied Biosystems QuantStudio™ 12K Flex Real-Time
PCR System, please see “Documentation and Support” on page 97. The related
documentation listed provide resources that detail general instructions applicable to
any experiment run on the QuantStudio'™ 12K Flex System.
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Overview of Digital PCR experiments
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Digital PCR experiment workflow. . ....... ... ... ... ... 12
DigitalSuite™ SOftware. . . . ... ..ottt 13
Analysis Workflow .. ... 14

Digital PCR provides sensitive, precise, and absolute quantification of nucleic acids
without the use of a standard curve. The following components are required to
perform digital PCR on the QuantStudio'" 12K Flex System:

QuantStudio™ 12K Flex System — Instrumentation used to load, cycle and detect
targets using digital PCR analysis.

QuantStudio™ Digital PCR Plates — Reaction vessels used to contain the digital
PCR reactions for thermal cycling and the subsequent imaging by the
QuantStudio™ 12K Flex System.

TagMan® OpenArray® Digital PCR Master Mix and Assays — Fluorescence-
based polymerase chain reaction (PCR) reagents used to amplify and detect
nucleic acid targets for digital PCR analysis.

DigitalSuite™ Software — Software used to complete statistical analysis of the
digital PCR experiments performed on the QuantStudio™ 12K Flex System.

The Applied Biosystems QuantStudio'" 12K Flex Real-Time PCR System consists of
the following components:

OpenArray® AccuFill"" System — Loads your samples onto an OpenArray®
Digital PCR Plate.

QuantStudio™ 12K Flex Instrument — Performs thermal cycling and imaging of
the experiment plates.

Computer — Connects to the QuantStudio™™ 12K Flex Instrument. Also has the
QuantStudio™ 12K Flex Software installed on it.

The QuantStudio™" 12K Flex System requires two plate types:

e QuantStudio™ OpenArray® 384-Well Sample Plate (sample plate)
* QuantStudio™ Digital PCR Plate (experiment plate)

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 9
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QuantStudio™ OpenArray® 384-Well Sample Plate

The QuantStudio™ OpenArray® 384-Well Sample Plate is a 384-well reaction plate that
is provided in the OpenArray® Real-Time Accessories Kit. You combine the TagMan®
OpenArray® Digital PCR Master Mix, TagMan® assay, and your DNA sample in the
sample plate, then use the OpenArray® AccuFill"™ System to transfer the mixture from
the sample plate to an OpenArray® plate(s).

IMPORTANT! The well dimensions of the QuantStudio™ OpenArray® 384-Well Sample
Plates are specifically suited for use with the OpenArray® AccuFill™ System. Life
Technologies does not recommend the use of other microtiter plates with this system.

QuantStudio™ Digital PCR Plate

The QuantStudio™ Digital PCR Plate is a 63-mm x 19-mm mid-density reaction plate.
Each plate contains 3072 reaction through-holes, each of which can accommodate a 33-
nL reaction volume. The QuantStudio™ Digital PCR Plate is divided into 48 subarrays,
where each subarray consists of 64 through-holes. Hydrophilic and hydrophobic
coatings allow reagents to be held within the through-holes and isolate the reactions
from neighboring through-holes. The large number of reaction through-holes along
with the precise control of reaction volume provide a robust platform for digital PCR
experimentation.

What is a digital PCR experiment?

Digital PCR is a statistical technique requiring tens to thousands of reaction replicates
to accurately quantify the absolute number of starting copies of a target nucleic acid
sequence in a genomic or complementary DNA (cDNA) sample without the use of a
standard. Digital PCR analysis requires that at least some reactions within the sample
replicate group have zero copies (individual PCR reactions will contain either zero,
one, or a few target molecules). Amplification is detected in reactions receiving at least
one molecule and classified as positive while no amplification is detectable in reactions
not receiving target and is conversely classified as negative. Following PCR, the
number of positive and negative reactions is counted and fit to a Poisson distribution
to estimate the absolute copies of template molecules present in the sample volume.

For concentrated samples, dilution to the single-molecule limit may be required. For
detection of rare targets (mutant sequences, pathogens, transgene content) dilution is
generally not required.

Applications of digital PCR include, but are not limited to, quantification of low-level
pathogens, detection of rare sequences, gene expression in single cells, and low-fold
copy number discrimination of genes/targets.

Digital PCR experiments include the following components:
¢ Sample — The genomic or cDNA sample that contains an unknown number
of copies of the target nucleic acid sequence.

¢ TagMan® OpenArray® Digital PCR Master Mix — An optimized mixture of
dNTP, salt, buffer, AmpliTaqg® DNA Polymerase, and ROX"" dye passive
reference designed for use with TagMan® Assays and the QuantStudio™ 12K
Flex System.

* TagMan® Assay - Includes forward and reverse primers and a specific
fluorescent dye-labeled probe for the target nucleic acid sequence.

Applied Biosystems OpenArray® Digital PCR Experiments User Guide
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The probe contains:

-~ A FAM™ dye (or VIC® dye, in case of a duplex experiments) reporter
dye linked to the 5" end of the probe.

— A minor groove binder (MGB) at the 3" end of the probe.

MGB increases the melting temperature (Tm) without increasing probe
length (Afonina et al., 1997; Kutyavin et al., 1997); enabling the design of
shorter, more specific probes.

— A nonfluorescent quencher (NFQ) at the 3" end of the probe. Because
the quencher does not fluoresce, the QuantStudio'" 12K Flex Instrument
can measure reporter dye contributions more accurately.

¢ Technical replicates — Through-hole reactions of each subarray that contain

identical sample/assay/reaction mix combinations and volumes. Each
subarray of the OpenArray® Digital PCR Plate contains a minimum of 64
technical replicates (resulting from a single well of the 384-well sample
plate).

(Optional) No template controls (NTCs) — Samples that contain water or
buffer instead of template; also known as negative controls. NTCs should not
amplify.

IMPORTANT! In DigitalSuite™ Software, NTC is not an assigned task. You
can identify a negative control in the Software by naming a Sample "NTC" or
something similar. The Software ‘treats’ the NTC-named samples in the same
way as the other samples. You need to look out for any amplification in the
NTC-named samples as the Software does not produce a flag if amplification
occurs in those wells.

In a digital PCR experiment performed on the QuantStudio™" 12K Flex System,
dilutions of each gDNA or cDNA sample are loaded into the wells of an QuantStudio™
384-Well Sample Plate that contain TagMan® OpenArray® Digital PCR Master Mix and
TagMan® Assay. If the target concentration is high, samples are diluted down to a
limiting quantity prior to assembly of the reaction mix in the QuantStudio™" 384-well
Sample Plate, such that a portion of the individual PCR reactions receive no target
molecules.

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 1
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Digital PCR experiment workflow

Digital PCR experiment workflow

Prepare the Digital PCR Reactions

1. Prepare the reaction mix.
2. Assemble reactions in the QuantStudio™ 384-well sample plate.

Load the OpenArray® Digital PCR Plate

1. Load the OpenArray® AccuFill™ tips, OpenArray® 384-well Sample Plate
and QuantStudio™ Digital PCR Plate(s) onto the AccuFill™ System.

2. Run the OpenArray® AccuFill™ System.

3. Seal the plate(s).

Perform Real-Time Imaging

1. Open the Data Collection software.

2. Select Digital PCR .edt (template) file.

3. Place the loaded and sealed QuantStudio™ Digital PCR Plates into the
QuantStudio™ 12K Flex Real-Time PCR System, then perform the run.

Review and Export the Run Data

1. Review the results.
2. Save the output .eds file.

Analyze the Data Using DigitalSuite™ Software

1. Create a study by importing the data .eds file.

2. Enter sample, target, and dilution information in Plate Setup.

3. Click Analyze and review results.

4. (Optional) View heat maps and amplification curves to optimize Analysis
Settings.

5. Save and export the results for downstream analysis.

12 Applied Biosystems OpenArray® Digital PCR Experiments User Guide



Chapter 1 Overview of Digital PCR experiments
DigitalSuite™ Software

DigitalSuite™ Software

DigitalSuite™ Software performs statistical analysis of the digital PCR experiments
performed using TagMan® Assays on the QuantStudio™" 12K Flex System. The
DigitalSuite"" Software can be used to detect and measure the absolute number of
molecules of specific sequences in a variety of biological samples.

™

Features The unique features of the DigitalSuite " Software include:

* Study-based analysis that can accommodate multiple OpenArrays at a time.
* Accommodates both duplex and singleplex experimental designs.

* Manual and automatic empty well calls.

* Inclusion or omission of individual targets in a well.

* Results generation and re-analysis using an updated dataset.

¢ Customization of digital PCR settings, flags, and Poisson calculations.

* Export or import of experiment analysis settings.

* Enables viewing of amplification curve groups by target, sample-target and/
or sample-target-dilution.

* Provides a histogram plot that helps in distinguishing amplifications.
¢ Both auto or manual call amplification/non-amplification/undetermined.
* Reporting of results in copies per uL using configurable well volume.

¢ Individual well-bookmarking enables respective views of the data across the
platform.

* Exporting results.
¢ Print, save to an image file, or export plots.
* Visualization features such as Heat Maps, Scatter Plots and Bar Plots.

Compatible instruments

DigitalSuite™ Software can be used to analyze the results of digital PCR experiments
run on the QuantStudio™ 12K Flex System that have been exported as raw
amplification curve data (.eds) files.

About the analysis

DigitalSuite™ Software generates copy number data from fluorescence data collected
from TagMan® reactions that have been loaded onto a QuantStudio™ Digital PCR
Plate and run on a QuantStudio' " 12K Flex System. Following thermal cycling, the raw
amplification curve data from the digital PCR experiment are exported from the data
collection software, QuantStudio " 12K Flex Software. The exported file is then loaded
by the DigitalSuite'" Software for analysis.

DigitalSuite™" Software generates calls for all the through-hole reactions. Using the call
data, the OpenArray® Digital PCR Software calculates copy number values for all
samples present on the plate and, by default, generates 95% confidence intervals
according to a Poisson maximum-likelihood algorithm (Fazekas de St. Groth, S, 1982).

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 13
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Analysis workflow

DigitalSuite™ System requirements
Software

: ; High-level system requirements are as follows:
installation

e 24GHzCPU
e 2GBRAM

Disk space

Target computer with one hard drive, or no partitions:

* 20 GB of disk space is required.

Target computer with two hard drives, or two partitions:

* 20 GB of disk space is required for the applications drive
* 300 MB of disk space is required for the programs drive

Target computer with three hard drives, or three partitions:

* 20 GB of disk space is required for the applications drive
¢ 300 MB of disk space is required for the programs drive
* 1 GB of disk space is required for the user files drive

Locate the executable file

Install the software at C:\Program Files\ AppliedBiosystems\ DigitalSuite Software.

Analysis workflow

The recommended workflow for analyzing results is:
1. Launch DigitalSuite™ Software.
2. Click Create Study to begin a new study.

3. Import the data files into the study.
Note: The Import dialog box opens automatically on clicking Create Study.

4. Assign sample name and target information for all wells.

5. Analyze and view results.

14 Applied Biosystems OpenArray® Digital PCR Experiments User Guide



Perform a Digital PCR Experiment

Prepare the OpenArray® 384-Well Sample Plate. .. ................ooooe... 15
Prepare the QuantStudio™ Digital PCRPlate. ............................ 16
Run the QuantStudio™ Digital PCRPlates ............. ..., 17
Analyzethedata.......... .. ... . . 18

Prepare the OpenArray® 384-Well Sample Plate

Determine layout
of the sample plate

Prepare the
sample plate

About the sample plate

The OpenArray® 384-Well Sample Plate is divided into eight areas; each sample plate
area is 12 wells x 4 wells (48 wells). During each load, the OpenArray® AccuFill™
System transfers sample from one area of a single sample plate to the respective
QuantStudio™ Digital PCR Plate, each well of the sample plate loading an individual
subarray on the OpenArray® Plate.

Plate Area 4 (detail)

Columns 13-24

/A 2 4 @ B 10 12 4 18 B N 2 A EEEEEEEEEEEE
¢ doooogogooog

Columns 1-12 Columns 13-24

SRl B - Plate-area-1 - |- Plate-area 2 Rows E-H [S S S NN R DT

Y=l = Plate area 3 | Plate area 4

SIBM | | Plate areab | Plate area 6

SV RE I - Plate area 7 - |;{Plate area 8
\_

O0O0O0oOOoOooOoooo
|

Determine the layout of the sample plate

1.
2.

Label the sample plate with a unique identifier.

Determine which sections of the sample plate you will load with sample. Each 12-
well x 4-well rectangular area corresponds to one QuantStudio™ Digital PCR
Plate. You may find it helpful to mark the sample plates with a fine-tip marker.

A single QuantStudio™ Digital PCR Plate accepts one load from a sample plate. Be
sure that the QuantStudio™ OpenArray® 384-Well Sample Plate, OpenArray®
AccuFill™ Loader Tips, and Plate Holder are completely clean and dry.

IMPORTANT! Residual water prevents correct loading of the samples into the
QuantStudio™ Digital PCR Plates.

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 15



Chapter 2 Perform a Digital PCR Experiment

Prepare the QuantStudio™ Digital PCR Plate

Storage conditions

1. Prepare the PCR mix.

Note: For detailed preparation instructions on making the PCR mix, refer to the
Applied Biosystems QuantStudio™ 12K Flex Real-Time PCR System: OpenArray®
Experiments User Guide (Part no. 4470935).

2. Add sample, master mix, and assay(s) to the sample plate.

3. (Optional) Store sealed sample plates.

The following materials require special storage conditions:

Item

Storage Conditions

QuantStudio™ Digital PCR Plate

If the OpenArray®
plate is...

Frozen, unopened
Thawed, unopened

Thawed, opened

Store at -20°C until the expiration date provided on the product label.
Store at room temperature for up to 24 hours.

Store at room temperature for up to 1 hour.

Prepare the QuantStudio™ Digital PCR Plate

Required materials

16

The consumables, materials, and equipment listed are specific to digital experiments.

Itemt Source Part no.

QuantStudio™ Digital PCR Kit available as 10 Life Technologies 4470184 (10 pk)

Pack or 4 Pack

e The 10 Pack includes 10 QuantStudio™
Digital PCR Plates (Part no. 4470197), 2X
TagMan® OpenArray® Digital PCR Master
Mix (5 mL, Part no. 4458080), and
QuantStudio™ OpenArray® Real-Time PCR
Accessories Kit (Part no. 4469576)

e The 4 Pack includes four QuantStudio™
Digital PCR Plates (Part no. 4470196) and 2X
TagMan® OpenArray® Digital PCR Master
Mix (1.5 mL, Part no. 4458086)

Note: The QuantStudio™ OpenArray®
Accessories Kit (Part no. 4469576) is included
with the 10 Pack but must be purchased
separately with the 4 Pack.

4470185 (4 pk)

DigitalSuite™ Software Life Technologies 4472102

DigitalSuite™ Software License Keys (10 pack) | Life Technologies 4472103 (10 pk)
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Chapter 2 Perform a Digital PCR Experiment 2
Run the QuantStudio™ Digital PCR Plates

ltem? Source Part no.
QuantStudio™ OpenArray® AccuFill™ System Life Technologies 4471021
Foil seals Major Laboratory ' —
Suppliers (MLS)
QuantStudio™ OpenArray® Accessories Kit Life Technologies 4469576

The accessories kit contains:
 QuantStudio™ 12K Flex OpenArray® Case
e QuantStudio™ 12K Flex OpenArray® Lid
 QuantStudio™ 12K Flex OpenArray® Plate

Press 2.0
Ethanol MLS —
Razor blade MLS -
Powder-free nitrile gloves MLS ' —
Laboratory-grade wipes MLS —

Tweezers (to remove foil from the sample plate) | MLS -

t For the Safety Data Sheet (SDS) of any chemical not distributed by Life Technologies, contact the chemical
manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all
relevant precautions.

Procedure For detailed instructions on the following prepatory and experimental procedures,
refer to the Applied Biosystems QuantStudio™" 12K Flex Real-Time PCR System:
OpenArray® Experiments User Guide (Part no. 4470935):

* Use the QuantStudio™" OpenArray® AccuFill™" System to transfer your DNA
samples and assays.

* Seal the QuantStudio™ 12K Flex OpenArray® Case.

* Load the prepared QuantStudio'" Digital PCR Plate into the QuantStudio"" 12K
Flex Instrument.

Run the QuantStudio™ Digital PCR Plates

Use the QuantStudio'" 12K Flex Software to run the QuantStudio™ Digital PCR Plate.
For Digital PCR experiments, the QuantStudio™ Software uses the Plate template file
(*.edt) type of data file.singleplex and duplex experiments require specific *.edt data
file. However, the *.edt file used for duplex experiments specifies that both FAM™" dye
and VIC® dye should be collected during the run.

Note: For detailed instructions on running the OpenArray® plates, monitoring
experiments, and transferring experiment results, refer to the Applied Biosystems
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray® Experiments User Guide (Part
no. 4470935):

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 17



Chapter 2 Perform a Digital PCR Experiment

Analyze the data

Analyze the data

18

View the data from the .eds file. If the default analysis settings are not suitable for your
experiment, you can modify the settings. You can also modify the project files, publish
data, and export data for downstream analysis using the DigitalSuite"" Software.

For detailed analysis and export procedures for example singleplex and duplex
experiments, refer to Chapter 3, “Analyze Experiment Results using DigitalSuite’
Software” on page 19.

M
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Chapter 3 Analyze Experiment Results using DigitalSuite™ Software
Overview

Overview

DigitalSuite™ Software is designed for rapid and accurate analysis of QuantStudio™
12K Flex digital PCR data. In this chapter, you use the example experiment files
provided during the DigitalSuite™ Software installation to analyze the digital
experiment results. A typical analysis workflow using the DigitalSuite™ Software
includes:

1. Launch DigitalSuite™ Software.
Create a study.

Import one or multiple *.eds file(s).
Setup plate layout.

Click Analyze.

View results.

A L R

(Optional) Conduct further analysis of the digital PCR data for quality by choosing
the Run QC option.

8. Export the analyzed data.

This chapter is divided into three sections. Section 3.1 provides the information and
instructions on the overall analysis workflow. Section 3.2 and Section 3.3 include
information specific to singleplex and duplex experiments, respectively.

20 Applied Biosystems OpenArray® Digital PCR Experiments User Guide



Section 3.1 General Analysis Workflow

Overview

Section 3.1 General Analysis Workflow

Both singleplex and duplex experiments follow the same general analysis procedure.
This section describes the general workflow for digital analysis of experiments. The
subsequent individual sections describe specific parameters. This section includes:

B Createastudy ...........uuuiiuiui e 22
Define study properties.......... ... ... ... 23
Setupplatelayout .......... ... 25
Set up Samples and Targets. . . ... 28
Analyzeastudy ...........c.iiii 31
View theresults. .. ... 32
Sample Grouptab....... ... . 32
Replicate Group tab ... ... 34

B (Optional) Perform QConresultsdata.............. ...t 37
HeatMap ... ..o 37
Viewthe Heat Map. ... ... ..o i 37
Amplification Plot ......... ... 40
View the Amplification Plot . ........ ... ... i 40
Flag Summary..........oo i 59

B Exporttheanalyzeddata............. ... ... .. L. 60
Export procedure ............ i 60

B Supporting features ........... ... 62
Preferences. . ... ... 62
Poisson Calculator ........ ... .. i 62

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 21



Chapter 3 Analyze Experiment Results using DigitalSuite™ Software
Create a study

Create a study

To create a new study, launch DigitalSuite™ Software and on the Home screen, click
Create Study.

Alternatively you can create a study from the File menu. Go to File » Create Study.

¥ DigitalSuite™ Software Version 1.0
Fle Edit Analysis Tools Help

| @ Create Study| @E_" E‘ S« Transfer Study In g'é},

Study Name L% Description # of Experiments Date Created Last Modified

Note: Launch DigitalSuite™ Software from:

e Start » All Programs » Applied Biosystems » DigitalSuite Software
or
* The Analyze menu on the Home screen of the QuantStudio™ 12K Flex Software

Clicking on Create Study takes you to the Plate Setup screen and automatically opens
the Import dialog box.

The default location of the *.eds file is C:\ Applied Biosystems\ DigitalSuite

Software\ User Files. To change the default location of the *.eds file, go to Tools »
Preferences. For more information on the Preferences dialog box, see “Preferences” on
page 62.

W Import E|
Look in: |E| User Files V‘ ¥ "\\El

D

My Recent
Documents

Desktop

My Documents
My Computer

.I'% File name: ‘ | [ Import ]

My Netwark
Places Files of type: ‘ Experiment Files (*.eds) "l [ Cancel ]

A study can include data from one or more OpenArray® plates.

Note: Life Technologies recommends that you do not mix singleplex and duplex
experiments in a single study.

Note: Click [§f5 Save or go to File » Save to save a study.
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Section 3.1 General Analysis Workflow

Create a study

Once a study is created and saved, the study name is displayed on the Home screen
along with the study properties including the study description, the number of
OpenArray® plates included present in the study, the date on which the study was
created and the date on which the study was last modified.

E - =[x

Fie Edit Analysis Tools Help

[€ create stuy | [€[Z] open study | (€ Transfer study out [§48 Transfer study In | (€72 Delete Study
2 %

Study Name Description # of Experiments Date Created Last Modified
ExampleStudy | 1 |02-02-2012 11:45:06 56T |02-03-2012 14:35:15 56T |
ExampleStudy2 | I |02-02-2012 15:18:10 56T |02-02-2012 15:31:30 56T |

A Home

e C(lick G2 Open Study to open a selected study from the study list on the Home
screen. Alternatively, you can double-click on a study name from the study list on
the Home screen.

* C(lick Eﬁl} Transfer Study Out to move one or more selected studies out to
another workstation running DigitalSuite" Software. Use the Transfer Study Out
feature to transfer studies into files that you can back up or pass to another user.

e C(lick E‘h Transfer Study In to bring in one or more studies from another
location. Only files of type *.1as can be transferred in to DigitalSuite" Software.

* C(lick Eﬁ' Delete Study to permanently delete a selected study from the study
list on the Home screen.

Define study Click Properties from the Setup menu located in the Workflow menu on the left to
properties access the Study Properties screen.

1. Enter a unique study name in the Study Name field.

¢ Enter a name that is descriptive and easy to remember. You can enter up to
100 characters

Applied Biosystems OpenArray® Digital PCR Experiments User Guide 23



Chapter 3 Analyze Experiment Results using DigitalSuite™ Software

Create a study

* You can only use the alpha-numeric, period (.), hyphen (-), underscore ( _)
and spaces () characters

"o

Note: You cannot use the following characters: % *? | ;:,l@#$ () <>/\
~[1{}=&"

. The Study contents box is automatically populated with:

* The number of experiments in the study
¢ The targets in the study
* The samples in the study

. The History Summary box is automatically populated with:

¢ The date and time stamp when the study was created
¢ The date on which the study was last modified

(Optional) Enter a description for the study in the Description field.

(Optional) Enter comments in the Comments field. Click Add to add the
comments to the comments list. You can add multiple comments at different time
intervals.

IMPORTANT! Comments added to the Study Properties are time stamped and
once added cannot be deleted.

The Study Properties screen for an example study is shown in the following image:

Study Properties

Study Name: ‘Examp\estudy

‘ Description

Study contents
Experiments in Study: 1
Targets in Study: 1
Samples in Study: 1
History Summary
Created on: 02-01-2012 14:56:06 SGT
Last Modffied on:

Comments:

>
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Set up plate layout

Section 3.1 General Analysis Workflow

Create a study

Click Plate Setup from the Setup menu to access the Plate Setup screen. The Plate
Setup screen is divided into two panes: “Manage Experiments” and “Plate Setup
for.(Study Name)”.

Manage Experiments

The Manage Experiments view lists all the *.eds files present in the study. The features
under Manage Experiments allow you to:

. Import one or multiple OpenArray data files (*.eds files) into a study.

. Delete one or multiple experiments from a study.

. ‘Eﬁ Generate Plate Temp‘ate‘ Generate plate templates (*.xIs files), containing setup
information (target name and color, sample name and color, dilution and color) to
use for OpenArray® plates in a study. The plate template is generated from the
OpenArray data file currently selected.

o |F* Loadpbre Tempbte‘ Load setup information (target name and color, sample name
and color, dilution and color) from plate templates into one or more selected
experiment files.

You can view experiment file name, barcode information, the date on which the
experiment was added, and comments in the Manage Experiments view.

Note: Comments added to the Plate Setup in the comments field are editable.

Plate Setup for: (Study Name)

The features under the Plate Setup view allow you to assign plate information. The
elements of the Plate Setup view are described below.

Assign

Use the Assign feature to assign well contents for a particular sub-array(s) in an
experiment.

1. Select one or more sub-arrays in the plate layout.

Note: You can select multiple sub-arrays by ‘click and drag’ action over the plate
layout, the column headings, or the row headings. You can also use Ctrl or Shift to
select multiple sub-arrays.

4, assan| above the plate layout. Alternatively, right-click on a sub-array or a
group of sub-arrays and select Assign Well Content from the drop-down menu.
If you are assigning contents to a single sub-array, double-click to open the well
editor.

Note: The Assign button remains disabled until you select one or more sub-
arrays in the plate layout.
3. In the Assign Well Contents editor:
a. Select TagMan® Assay 1 or enter a name of your choice for the Target (FAM).

b. (Optional) Select a color for the target from the corresponding drop-down
menu.
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Create a study

For duplex experiments, select or enter a name of your choice for the Target
(VIC). Optionally, select a color for the target from the corresponding drop-
down menu.

For singleplex experiments, Target (VIC) is disabled.

c. Select DNA Sample 1 or enter a name of your choice for the Sample.
Optionally, select a color for the sample from the corresponding drop-down
menu.

d. Select a dilution from the Dilution drop-down menu or enter a dilution of
your choice. Optionally, select a color for the dilution from the
corresponding drop-down menu.

Note: When you enter a new name for targets, samples, or dilution, the
option gets populated in the Samples/Targets screen.

Note: When you enter a target or sample name of your own choice, Life
Technologies recommends that you use short names, especially when you
have a large number of Sample or Replicate Groups. Due to the limited
screen size, longer names will truncate on the Results Plot in the Digital PCR
screen.

4. Click Done after selecting or entering criteria or Cancel to exit the Assign Well
Contents editor without assigning.

Note: You can also copy well contents from one or multiple sub-arrays to another
location using the right-click option. In the plate layout, select one or multiple sub-
arrays; right-click and select Copy Wells from the drop-down options. Select the sub-
array at the top-left corner of the destination location and select Paste Wells from the
right-click drop-down options to paste.

Select Clear from the right-click drop-down options to clear well information from a
sub-array.

Show
Use the Show feature to display or hide the well contents in the sub-arrays.
1. Click Show above the plate layout.

2. Select the well contents Sample, Target (FAM), Target (VIC), Dilution to show or
hide from the drop-down menu.

Plate Setup for: SingleplexExample.eds

E‘% Assign |
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% show - # Color by: Sample - Legend i”% 3@ =) li@ "— IE‘
— 3 | 4 | 5 \ 3 \ 7 | 8 | E | 10 | 1 | 12 |
Target (FAM)
Target (VIC)
Dilution
Color by:

Use the Color By feature to display the sub-arrays with the color of the selected well
contents.

1. Click Color by: above the plate layout.
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Create a study

2. Select from Sample, Target (FAM), Target (VIC), Dilution in the Color by drop-

down menu.

Plate Setup for: SingleplexExample.eds

% Assignl % Show - w Color by: Sample vI

1 2] Sample

Target {FAM)
Target (VIC)
A Dilution

Legend
Click

In addition, the Plate Setup for: view contains the following tools:

gend| above the plate layout to show or hide the plate layout legend.

Tool

Function

Jjo

Zoom in to the plate layout

I
&

Zoom out of the plate layout

o]

Fit plate layout to window

Print the current plate layout

[ww]
B”

Copy the current plate layout

Save the current plate layout as an image

View the current plate out in full screen

H 2

Exit full screen view of the plate layout

Applied Biosystems OpenArray® Digital PCR Experiments User Guide
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Create a study

The Plate Setup screen for an example study is shown in the following image:

Manage Experiments

== Import | == Delete B Generate Plate Template e Load Plate Template

File Name

Example.eds

Barcode
|Fokz3

Date Added Comments
[0z 022012 11:45:16 56T |

Plate Setup for: SingleplexExample.eds

% Assign | % show - y Calor by: Dilution vl Legend

IDMA Sample 1
... [| Tagman Assa...
0.5

IDMA Sample 1
...[[Tagman Assa...
0.5

IDMA Sample 1
... [[Tagman Assa...
0.5

IDMA Sample 1
... [Tagman Assa...
0.5

e
| Bl
[ Blank well (0)

H o (258)

[ 0.5 (704) M 0.25 (704) W 0.125 (704)

Set up Samples
and Targets
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You can prepare the well contents, including samples, targets, and dilutions in the
Samples/Targets screen. The samples, targets, and dilutions created in the Samples/
Targets screen are populated in the respective drop-down menus of the Well Editor in
the Plate Setup screen. You can then select the sample name, target name, and
dilutions from the previously-created options. For information on setting up samples,
targets, and dilutions in the Samples/Targets screen, see Set up Samples and Targets
below.

Click Samples/Targets from the Setup menu to access the Samples/Targets screen. The
Samples/Targets screen is divided into three sections: Manage Samples, Manage
Targets, and Manage Dilutions.

Manage Samples

1. Click to add samples to a study. DNA Sample 1 is the default sample
names that appears in the Manage Samples section.

2. (Optional) Select a color for the sample from the color drop-down.
3. (Optional) Enter comments in the Comments column.

4. Click to delete selected samples from a study.

Note: You cannot delete the sample names that have been assigned to wells in an
experiment included in the study.
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Create a study

Note: The number of wells appearing against a sample name is automatically updated
as per the assignment in the Plate Setup screen.

Manage Targets

1.

Click to add targets to a study. The default target name that appears in the
Manage Targets section is TagMan® Assay 1.

Select the Reporter for the target from the Reporter drop-down menu.

Note: For studies containing singleplex experiments, only FAM™ dye is available
in the Reporter drop-down menu. For studies containing duplex experiments,
FAM™ dye and VIC® dye are available in the Reporter drop-down menu.

(Optional) Select a color for the target from the color drop-down.

(Optional) Enter comments in the Comments column.

Click to delete selected targets from the study. You cannot delete the
target names that have been assigned to wells in an experiment included in the
study.

Note: The number of wells appearing against a sample name is automatically updated
as per the assignment in the Plate Setup screen.

Manage Dilutions

1.

Click to add dilutions. The default dilutions that appear in the Manage
Dilutions section are 1, 0.1, 0.01, 1E-4, 0.

The DigitalSuite™ Software computes the next dilution based on the dilution
factor. Enter a value from 2 to 100. The default dilution factor is 10.

The corresponding row in the Fold column gets populated with the dilution fold
for that particular factor.

Note: For the dilutions, you can enter numeric values or scientific notations like
1E-3 or 0.5E-4.

(Optional) Select a color for the dilution from the color drop-down.

Click to delete the selected dilutions from the study.

Note: You cannot delete the dilutions that have been used in an experiment
included in the study.
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Create a study

The Samples/Targets screen for an example study is shown in the following image:

Manage Samples Manage Dilutions
,_‘_,a Add | == Delete | Diution Factor:

== Add | == Delete
Name Color Comments # of Wells Dilution Fold Color
DN& Sample 1 ] v 2,816 1 1i v
NTC T 256 0.1 1o v
DNA Sample 2 ] v 0 0.01 100 v
1E-4 1E4 v
0 NTC] ~
0.5 2 b
0.25 4 v
8 v
0.001 1,000 v
1E5 =] v
== Add | = Delete
Name Reporter Color Comments # of Wells
Tagman Assay 1 FAM v [l v 3,072
Tagman Assay 2 FAM v- 3 a

IMPORTANT! You can rename samples, targets, and dilutions after you have analyzed
the study. However, the Results, Run QC, and Export options will get disabled until
you re-analyze the study.
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Analyze a study

Analyze a study

You can analyze a study after you have completed plate set up for the experiment(s) in
that study. In the absence of plate set up, the Analyze button appears disabled.

Click to analyze a study. The DigitalSui’ceTM Software carries out analysis and
displays the analysis results in the Digital PCR screen.

Note: The Results, Run QC, and Export options from the Workflow menu remain
disabled until analysis is done.

If the default analysis settings in the DigitalSuite™ Software are not suitable for your
own experiment, you can change the settings in the Analysis Settings dialog box, then
reanalyze your study. To revert to the default settings, click Reset to Defaults at the
bottom-left of the Analysis Settings dialog box.

=

M= Analyss Setngs) o access the Analysis Settings dialog box.

Analysis settings Digital PCR settings

Use the Digital PCR Settings tab to change the Confidence Interval, Well Volume, and
the Sample Group-Specific Settings.

* Confidence Interval: The Confidence Interval is used to calculate the lower and
upper confidence values in the Digital PCR screen. For example, for a Confidence
Interval value of 95%, the probability of copies/uL falling between the lower and
upper confidence values is 95%.

¢ Well Volume: The Well Volume is the actual volume of each through hole in an
OpenArray® plate.

IMPORTANT! This value is provided for reference purpose and should not be
changed unless specified.

* Sample Group-Specific Settings: This table contains settings for each sample
group in the study including the threshold values for the digital call (positive,
negative, and undetermined) as well as the threshold values for empty well
detection. See “Amplification Plot” on page 40.

Flag Settings

Use the Flag Settings tab to manually include or exclude a flag and to change the
threshold value. The flags present in this table include:

e Low FAM Score
e Low VIC Score

The default threshold value for both the flags is 1.24.
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View the results

¥ Analysis Settings

The Analysis Settings dialog box is shown in the following image:

‘W) Configure this analysis setting for the study.

Flag Settings
General
Confidence Interval (%): !95 Well Volume (uL): |0.033
Sample Group-Specific Settings
Target Sample Auto? | Min Pos CRT | MaxPos C... | Min Neg CrRT| Auto? | Low ROX Low Reporter
Tagman Assay 1 [DNA Sample 1 gyl 2Rl 36.1 180.71 437.85
Tagman Assay 1 [NTC 5 38 39 359,22 435,13
OK and Analyze ] [ Cancel ]

View the results

Sample Group tab

32

The Digital PCR screen displays the analysis results for all the experiments in a study.
Irrespective of the experiments, the results are grouped by Samples and Replicates.
The screen consists of the Sample Group tab and the Replicate Group tab.

The Replicate Group tab displays results for individual dilutions. The Sample Group
tab displays the aggregate results for the entire dilution series.

The Digital PCR screen also displays the Confidence Interval for that study in the title
bar of the screen. The default value for the Confidence Interval is 95%. This value can
be changed in the Analysis Settings dialog box (see “Analysis settings” on page 31).

The Sample Group represents all replicates that are assigned with the same sample
and target, regardless of the original plates they belong.

The Sample Group tab table includes the following;:

Column Description
Target Displays the target name
Sample Displays the sample name
Copies/uL Displays the quantity of sample in copies/pL

Lower Confidence Level | Displays the lower confidence level for the quantity of sample in
(Lower Conf] copies/uL

Upper Confidence Level | Displays the upper confidence level for the quantity of sample
(Upper Conf) in copies/ulL

o Displays total number of positive calls

Note: Positive calls mean the DigitalSuite™ Software
determines a well containing at least one copy of the sample.
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View the results

Column Description

(—] Displays total number of negative calls

Note: Negative calls mean the DigitalSuite™ Software
determines that a well does not contain any copy of the sample.

Displays total number of undetermined calls.

Note: Undetermined calls are those that occur between the
positive and negative range as well as beyond the positive range
on the histogram plot.

# of Positive + Negative | Displays the combined number of wells having the positive and

(# of Pos+Neg]) negative calls
# of Omitted Displays the number of wells omitted from the study
# of Empty Displays the number of empty wells

Note: Empty wells are those that are flagged with Low ROX,
Low FAM, or Low VIC.

On selecting the Sample Group tab, the corresponding Sample Group Results are
displayed in the form of a bar graph, with the Sample Group on the X-axis and Copies/
pL on the Y-axis, in the lower-half of the Digital PCR screen.

1. To view the plot type, click Plot: and select Linear Axis or Logarithmic Axis from
the Plot drop-down menu.

Sample Group Results

|~__~§ Plot: Linear Axis +| ¥ View - M Color by: Target -
Linear Axis i
Logarithmic Axis
| =

2. Click View » Legend to show or hide the plot legend.

Sample Group Results

|=¥ Plot: Logarithmic Axis ~ View =

100 ~‘
3. Click Color by: and select Target or Sample from the Color by: drop-down menu
to assign the bars on the graph with the target or sample color.

# Color by: Target ~

Sample Group Results

|£§. Plot: Logarithmic Axis ~ & View = ﬂ Color by: Target ~

100 Target %
Sample

4. Move the cursor over the bars in the graph to view the values for Copies/uL,
Lower Confidence, and Upper Confidence.

5. To view only specific bars, select the respective rows in the table in the upper half
of the screen.

Note: To de-select a row, click on that row while holding down the Ctrl key.
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View the results

The Digital PCR Sample Group screen is shown in the following image:

Sample Group Replicate Group

Digital PCR - 95% Confidence Interval

# Target Sample CopiesfulL Lower Conf Upper Conf [+ R -] # of Pos+Neqg | # of Omitted # of Empty
1 Taqmen Assy 1 |DNA Samplel | 41.2] 38.9|

43.8] 1,184  1,620] 3 2,813 0| i

2  Tagman Assay 1 ‘NTC

| 1A /A

/A 0 254 0 254| o] 2

WA

=¥ Plot: Logarithmic Axis ~ ¥

100

Copiesiul

0.001

0.0001

0.00001

0.000001

0.0000001

Sample Group Results

View = # Color by: Target ~

P rBanhrE

Tagman Assay 1
DHNA Sample 1

Tagman Assay 1
NTC

Sample Group

Legend
’7. Tagman Assay 1 (2)

T 95% Confidence Interval

Replicate Group
tab
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The Replicate Group represents all replicates that are assigned with the same sample,
target, and dilution regardless of the original plates they belong.

The Replicate Group tab table includes the following;:

Column Description
Target Displays the target name
Sample Displays the sample name
Dilution Displays the dilution for that group
Copies/ulL Displays the number of replicate group copies present per pL

Lower Confidence Level
(Lower Conf)

Upper Confidence Level
(Upper Conf)

Displays the lower confidence level for the number of copies
present per pL

Displays the upper confidence level for the number of copies
present per pL

L+

Displays total number of positive calls

Note: Positive calls mean the DigitalSuite™ Software
determines a well containing at least one copy of the sample.
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View the results

Column Description

(—] Displays total number of negative calls

Note: Negative calls mean the DigitalSuite™ Software
determines that a well does not contain any copy of the sample.

Displays total number of undetermined calls.

Note: Undetermined calls are those that occur between the
positive and negative range as well as beyond the positive range
on the histogram plot.

# of Positive + Negative | Displays the combined number of wells having the positive and

(# of Pos+Neg]) negative calls
# of Omitted Displays the number of wells omitted from the study
# of Empty Displays the number of empty wells

Note: Empty wells are those that are flagged with Low ROX,
Low FAM, or Low VIC.

On selecting the Replicate Group tab, the corresponding Replicate Group Results are
displayed in the form of a bar graph, with the Replicate Group on the X-axis and
Copies/uL on the Y-axis, in the lower-half of the Digital PCR screen.

1. To view the plot type, click Plot: and select Linear Axis or Logarithmic Axis from
the Plot drop-down menu.

Replicate Group Results

|~__~§ Plot: Linear Axis - |¥  View - M Color by: Target -
|

3. Click Color by: and select Target, Sample, or Dilution from the Color by: drop-
down menu to assign the bar graph with the target, sample, or dilution color.

WA

Replicate Group Results

|~__~§ Plot: Linear Axis - ¥ View - M Color by: Target -
Target |
45 Sample
a0 J ; Dilution

4. Move the cursor over the bars in the graph to view the values for Copies/uL,
Lower Confidence, and Upper Confidence.

5. To view only specific bars, select the respective rows in the table in the upper half
of the screen.

Note: To de-select a row, click on that row while holding down the Ctrl key.
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The Digital PCR Replicate Group screen is shown in the following image:

Digital PCR - 95% Confidence Interval
Sample Group Replicate Group
# Target Sample Dilution CopiesfuL Lower Conf Upper Conf Q @ # of Pos+Neg # of Omitted # of Empty
1 Tagman Assay 1 |DMA Sample 1 1 41.8] 38.1 45.8| 526 177| 1 703 0 0
2 Tagman Assay 1 |DNA Sample 1 0.5 19.5] 17.5 21.8| 334 369 1 703 0 0
3 Tagman Assay 1 |DNA Sample 1 0.25 10.4] 9.09| 12.0 205] 499 0 704 0 0
4  Tagman Assay 1 |DMA Sample 1 0.125 5.62| 4.69| 6.73 119 584 1 703 0 0
5 Tagman Assay 1 |NTC 0 T/ 4| N/a| I/ A 0 254 0 254 0 2
A
Replicate Group Results
|=% piot: Linear Axis - ¥ View - W Color by: Target - /@ /@ Ffl‘ % E[‘Q] g E‘
45
40
35
30
—
e
4 25
[=%
© 20
15
10
5 -
[n)
Tagman Tagman Tagman Tagman Tagman
Assay 1 Assay 1 Assay 1 Assay 1 Assay 1
D.. D.. D.. D.. -
Replicate Group

In addition to the tools mentioned above:

* The Sample Group Results and Replicate Group Results plot view includes ,
, , and [&l| to zoom in, zoom out, to fit data in window, and to view data in
full screen respectively.

* C(lick , , and to print, copy, and save the plot as an image respectively.

* C(lick = to access and edit the Plot Properties such as the font and color of the
plot text, and the labels on the X axis and Y Axis. Edit the settings under the
General, X Axis, and Y Axis tab.

— Click the General tab to edit the plot title text, font, or color. You can also
select whether to show the plot title.

— Click the X Axis tab to edit the x axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

— Click the Y Axis tab to edit the y axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

— Click OK.
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(Optional) Perform QC on results data

You can perform a quality check on the digital PCR data and conduct further analysis,
if necessary. Use Heat Maps, Amplification Plots, and Flag Summary from the Run QC
Workflow.

Heat Map The heat map provides you with an overview of all the wells in the same plate. By
default, the Heat Map is colored by “Call’. The green wells represent positive calls
while the black wells represent negative calls. The grey wells represent undetermined
calls. The heat map allows you to check for:

* The density of the positive and negative calls for quick visual review with respect
to the dilution series.
* Amplification in wells labelled as NTC. NTC wells are supposed to be negative.

¢ Sample filling problems or suspected contamination in the plate through
abnormal density patterns.

¢ Flagged wells. Conduct further investigation of flagged wells in the Amplification
Plot screen.

Note: Flagged wells are marked with a JAN triangle in the affected well.

View the Heat Map  Go to Run QC » Heat Map to access the Heat Map screen.

The Heat Map screen includes the Experiments view in the upper half and the Heat
Map for view in the lower half of the screen.

The upper half of the Heat Map screen lists the experiments included in the study
while the lower half displays the corresponding heat map for the experiment selected
in the Experiments (upper half) view.

Experiments

The Experiments view lists all the experiments included in a study. The Experiments
view table includes:

Column Description

Bookmark Indicates whether there are bookmarked wells in the experiment.

Note:

e To bookmark a well, select one or more wells in the plate
layout right-click and select Add Bookmark from the drop-
down menu

e Select Select all bookmarks to select all the bookmarked
wells in the current plate

¢ Select Clear selected bookmarks to clear bookmarks from
the selected wells

¢ Select Clear all bookmarks to clear all bookmarked wells off
the bookmark

IMPORTANT! Bookmarks are lost once you close a study.

File Name Displays the file name of an experiment in the study.
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Column

Description

Barcode

Displays the barcode of the OpenArray® plate on which the dPCR
experiment has been run.

RO
-

Displays the number of wells with low ROX signal.

Fim ‘

4

Displays the number of wells with low FAM™ dye signal.

WIC

1

Displays the number of wells with low VIC® dye signal (only for
duplex experiments). For singleplex experiments, this column
displays N/A.

Displays the number of wells with a FAM™ dye score that is lower
than the threshold value specified in the Analysis settings.

KL FI

Displays the number of wells with a VIC® dye score that is lower
than the threshold value specified in the Analysis settings (only for
duplex experiments). For singleplex experiments, this column
displays N/A.

Heat Map for (experiment name):

The Heat Map For: view displays the heat map for the experiment file selected in the
Experiments view. The tools on this view include:

Tool

Description

Displays the FAM™ dye signal in wells.

Displays the VIC® dye signal in wells (only for duplex experiments).
This button appears disabled for singleplex experiments.

Show -

Drop-down menu that enables you the option to show flags in
wells.

Color by: Call ~

Drop-down menu that enables you options to color the cells using
different data elements. Select Call, Cgy, Sample, Target, or
Dilution.

Omission -

Drop-down menu that enables you to omit flagged or contaminated
wells. You can copy the result from A1 sub-array to other sub-
arrays as well as apply to other plates.

Select Copy A1 to all sub-arrays (all dyes) or Apply to all plates
(all dyes)

Legend

Toggle button. Shows or hides the plate legend below the heat map.

To omit a particular well(s), select the well(s) in the plate layout, right-click on the
selection, and select Omit from the drop-down menu.

To include an omitted well(s), select the omitted well(s) in the plate layout, right-click
on the well(s), and select Include from the drop-down menu.
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(Optional] Perform QC on results data

In addition, the Heat Map for: view contains the following tools:

Tool Function

Zoom in to the heat map

Zoom out of the heat map

Fit heat map to window

Print the current heat map

Copy the current heat map

Save the current heat map as an image

View the current heat map in full screen

Exit full screen view of the heat map

N | File Name Barcode e I I I
SingleplexExample.eds FQK23 ‘ 3| Ul

Heat Map SingleplexExample.eds

@ FAM 0 | & show - # Color by: Call - Omission =
1 4
1 Sle7E] 112 1Z[34 5678 2 1

r Leged
I positive (1,183) M negative (1,883) W Undetermined (3) X Empty Well (3) % Omitted (0)
[ Blank wel (0) /\ Flagged (5) [] Bookmark (0)
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Note: Bookmarks are applied at the Replicate level For duplex experiments,
bookmarking wells for one reporter dye does not bookmark the same well with the
second reporter dye. To bookmark the same set of wells with the second reporter dye.

1. Go to Run QC » Heat Map.

2. In the Heat Map, right-click and select Select all bookmarks from the menu to
select all bookmarked wells.

3. Click the other reporter bye button in the tool bar to switch to the Heat Map for
that reporter dye.

IMPORTANT! Do not left-click anywhere in the heat map at this point as it will
clear the well selection.

4. With the wells still selected, right-click on the wells, and select Add bookmark
from the menu to add the bookmark for the same set of wells for the second
reporter dye.

You can now view the bookmarked wells for the second reporter dye in the well
table in the Amplification Plot screen.

Amplification Plot The Amplification Plot of a study displays the amplification curve for wells grouped
by Target, Target and Sample (Sample Group), or Target, Sample, and Dilution
(Replicate Group). Two types of amplification plots are available:

* ARvs. Cycle — AR is the baseline adjusted fluorescence signal generated by the
reporter at each cycle during the PCR amplification. This plot displays AR as a
function of cycle number. You can use this plot to identify and examine irregular
amplification and to view Cgy values for the run.

* Ryvs. Cycle - R is the absolute fluorescence signal from the reporter dye. This plot
displays R as a function of cycle number. Use this plot to identify and examine
irregular amplification.

Each plot can be viewed as a linear or log10 graph type.

Note: For the Sample Group view, there is an additional plot, ROX vs. Reporter Dye
available.

Purpose

The purpose of viewing the amplification plot in a study is to:

* Review analysis results, including Cr value; Amp Score; Positive, Negative or
Undetermined calls, and empty wells detection
¢ Review the Histogram of the Ciy values for the selected Sample Group

* Adjust the thresholds for making positive, negative, or undetermined calls for the
selected Sample Group

¢ Evaluate the quality of the amplification curve, especially those wells containing
flags and if necessary, omit those

* Manually change calls or empty wells detection results

View the The Amplification Plot screen include three views:
Amplification Plot o Targets
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¢ Sample Group
¢ Replicate Group

Section 3.1 General Analysis Workflow

(Optional] Perform QC on results data

Target view
The Target table lists the targets in the study. The Targets table includes the following
columns:
Column Description
Bookmark Indicates whether a target is present in a bookmarked well.
To bookmark a well:
¢ On the Heat Map screen, select one or more wells in the plate
layout right-click and select Add Bookmark from the drop-down
menu
or
e On the Amplification Plot screen, in the Well Table, select Add
Bookmark from the Bookmark drop-down menu or from the
right-click drop-down menu
Target Displays the target name.

Displays the number of wells with low ROX signal.

Displays the number of wells with low FAM™ dye signal.

Displays the number of wells with low VIC® dye signal (only for
duplex experiments). For singleplex experiments, this column

displays N/A.

Displays the number of wells with a FAM™ dye score that is lower
than the threshold value specified in the Analysis settings.

Displays the number of wells with a VIC® dye score that is lower
than the threshold value specified in the Analysis settings (only for
duplex experiments). For singleplex experiments, this column
displays N/A.

The lower half of the Targets view displays the plot view and well table. Use the ﬂ,
ﬂ, w ,and A buttons to extend the views horizontally or vertically.

You can select wells in the plot view or the well table. In the plot view, select wells by
clicking in the plot and dragging a rubber-band box. In the well table, select wells by
selecting the respective rows. Wells selected in the plot view will appear selected in the
well table and vice-versa. In the plot view, selected wells will appear colored, while
unselected wells will be hidden. To view unselected wells, go to View » Show
Unselected. The unselected wells will appear in grey color in the plot view. If no wells
are selected, the plot view displays all the wells in color.

The Plot View includes the following the tools:

Tool

Description

Drop-down menu that enables you to select from AR vs. Cycle
(Linear), AR vs. Cycle (Log), R vs. Cycle (Linear], and R vs. Cycle
(Log) plot types
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Chapter 3 Analyze Experiment Results using DigitalSuite™ Software

(Optional] Perform QC on results data

Tool

Description

M Color by: Call -

Drop-down menu that enables you to show and hide the following:
e |egend

e Show Unselected

* Cpgr

e Show Omitted

Note: The Cry for a given amplification curve is indicated by a red
triangular icon on the curve

Drop-down menu that enables you options to color the plot using
different data elements. Select Bookmarks, Targets, Wells, or Call

In addition to the tools mentioned above:

¢ The Targets plot view includes , , , and to zoom in, zoom out, to fit
data in window, and to view data in full screen respectively.

Note: To zoom into a particular area of the amplification plot, click at the center of
the area of interest then click .

e C(Click , , and to print, copy, and save the plot as an image respectively.

¢ Click =] to access and edit the Plot Properties.

The Plot view for the Targets tab of an example study is shown in the following image:

AR vs Cycle (Linear)
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The Well Table includes the following tools:

Section 3.1 General Analysis Workflow
(Optional] Perform QC on results data

Tool

Description

View -

e Call
e Call Type

e Omit

* Cgr

¢ Flags

¢ Bookmark

e Empty Well Flag
¢ Empty Type

e Amp Score
¢ Experiment
¢ Flag indicator

- Low ROX

- Low FAM

- LowVIC

- Low FAM Score
- Low VIC Score

S Drop-down menu that allows you to show or hide columns in a
table. Select or Deselect the following:

Note: Wells with undetermined calls are not flagged for Low
FAM Score or Low VIC Score even if their Amp Score value is
less than threshold.

Group by -

¢ None

e Experiment
¢ Expand Al
¢ Collapse All

Drop-down menu that enables you to group the targets by
experiments or by none. Select from:

Note: The Expand All and Collapse All options are enabled only
when Experiment is selected.

rl Bookmark -

Drop-down menu that enables you add, select, and clear
bookmarked wells. Select from Add Bookmark, Select all
bookmarks, Clear selected bookmark, Clear all bookmarks.

=, Change Cal ~

Drop-down menu that enables you to manually change the call for
a well(s). Select Positive, Negative or Undetermined.

You can also use this drop-down menu to Clear Manual Call, Mark
as Empty Well, Mark as Non-Empty Well, Auto Empty Detection.

Note: When you manually change the call for a well(s), the call will
remain unchanged even after you re-analyze the study.
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(Optional] Perform QC on results data

The following table provides definitions for the column headings that appear in the
tables in the Targets tab:

Column heading

Description

Well
Call

Displays the Well location

Displays the call in the well (Positive, Negative, or Undetermined)

Note: Positive calls are indicated by 9, Negative calls are
indicated by @, and Undetermined calls are indicated by

Call Type

Whether the call is Auto or has been changed manually

Bookmark

Indicates if the well is bookmarked

Omit

Includes a check box to omit a well

Empty Type

Whether the well has been labelled empty automatically or
manually

Crr

Crt value for a well

Amp Score

Amp Score value for a well

Experiment

3|

Name of the experiment to which the target belongs

Flag Indicator. Displays the number of flags in a well

RO
-

The icon displayed if the well is flagged with Low ROX

‘ Fam ‘
-

WIC |
-

The icon displayed if the well is flagged with Low FAM

| The icon displayed if the well is flagged with Low VIC (only for

duplex experiments). For singleplex experiments, this column
displays N/A

[
&

The icon displayed if the well is flagged with Low FAM Score

| The icon displayed if the well is flagged with Low VIC Score

Note: You can sort the table columns by clicking once on the column header. You can
change the sorting order with a second click. A third click will clear the sorting order.
You can sort the table columns at multiple levels. For example, click the Call column to
sort the columns by Call, then hold down the Ctrl key and click the Cgy column to sort
by Cgy the wells with the same call.
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(Optional] Perform QC on results data

The Well Table view for the Targets tab of an example study is shown in the following

image:
hY View - EGTDUD by - t. Bookmark ~ ZI_ Change Call ~
# well call Call Type [ omit &) | Empty Type CRT Amp Score Experiment i) B i T [ =
1 Alal o Auto O Auto 29.95 1.41/|SingleplexExample.eds 0 N/A /A ~
2 Ala2 0 Auto O Auto 30.96| 1.43|SingleplexExample.eds 1] LN /A
3 Ala3 0 Auto O Auto 30.81 1.42|SingleplexExample. eds [1] /A /A
4 Alad e Auto O Auto Undetermined| 0.00(SingleplexExample. eds [1] LN /A
5 A135 o Auto O Auto 30.01 1.41/|SingleplexExample.eds 0 N/A /A
[ Alab ° Auto O Auto Undetermined, 0.00|5ingleplexExample.eds 0 /A /A
7 Ala? ° Auto O Auto Undetermined| 0.00(SingleplexExample.eds [1] /& /A
8 Alag ° Auto O Auto Undetermined| 0.00(SingleplexExample.eds [1] /& /A
9 Albl @ [auto (] Auto Undetermined| 0.46|SingleplexExample.eds [1] IfA /A
10 Alb2 o Auto O Auto 30.29| 1.45/|5ingleplexExample.eds 0 /A /A
11 Alb3 0 Auto O Auto 30.66| 1.43|SingleplexExample.eds [1] /& /A
12 Alb4 ° Auto O Auto Undetermined| 0.00(SingleplexExample.eds [1] /& /A
13 A1bS 0 Auto O Auto 29.33 1.45(5ingleplexExample.eds 1] LN /A
14 Alb6 o Auto O Auto 29.38| 1.44|5SingleplexExample.eds 0 /A /A
15 Alb7 0 Auto O Auto 30.46| 1.46/SingleplexExample.eds 1] /& /A
16 AlbB o Auto O Auto 31.10 1.43(SingleplexExample.eds [1] /& /A
17 Alcl 0 Auto O Auto 29.78| 1.42(SingleplexExample.eds [1] /& /A
18 Alc2 o Auto O Auto 31.08| 1.45|5ingleplexExample.eds 0 /A /A
19 Alc3 0 Auto O Auto 31.11 1.44|SingleplexExample.eds 1] /& /A
20 Alcd e Auto O Auto Undetermined| 0.00(SingleplexExample.eds [1] /& /A
21 Al 0 Auto O Auto 29.32 1.45(SingleplexExample. eds [1] /& /A
22 Alco o Auto O Auto 30.21 1.44|5SingleplexExample.eds 0 /A /A
23 Alc? ° Auto O Auto Undetermined| 0.57|SingleplexExample.eds 1] Nj A /A
24 Alc8 0 Auto O Auto 31.00 1.43|SingleplexExample.eds [1] /A /A
25 Aldl 0 Auto O Auto 30.56| 1.43(SingleplexExample. eds [1] e /A
26 Ald2 e Auto O Auto Undetermined| 0.43|5ingleplexExample.eds 0 /A /A
27 Ald3 ° Auto O Auto Undetermined| 0.00(SingleplexExample.eds 1] Nj A /A
28 Aldd 0 Auto O Auto 30.21 1.43|SingleplexExample.eds [1] /A /A
29 AldS 0 Auto O Auto 29.62 1.44(SingleplexExample. eds [1] e /A 3

Sample Group view

The Sample Group table lists the sample groups (replicates assigned with the same
sample and target) in the study. The Sample Group table includes the following

columns:
Column Description
Bookmark Indicates whether a target is present in a bookmarked well.

To bookmark a well:

e On the Heat Map screen, select one or more wells in the plate
layout right-click and select Add Bookmark from the drop-down
menu
or

¢ On the Amplification Plot screen, in the Well Table, select Add
Bookmark from the Bookmark drop-down menu or from the
right-click drop-down menu

Target Displays the target name.

Sample Displays the sample name.

Copies/uL Displays the number of copies of the sample group per pL.

[+ Displays total number of positive calls.
Note: Positive calls mean the DigitalSuite™ Software determines a
well containing at least one copy of the sample.

[—] Displays total number of negative calls.

Note: Negative calls mean the DigitalSuite™ Software determines
that a well does not contain any copy of the sample.
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(Optional] Perform QC on results data

Column

Description

Displays total number of undetermined calls.

Note: Undetermined calls are those that occur between the positive
and negative range as well as beyond the positive range on the
histogram plot.

# of Positive +
Negative (# of
Pos+Neg)

# of Omitted
# of Empty

Displays the combined number of wells having the positive and
negative calls.

Displays the number of wells omitted from the study.
Displays the number of empty wells.

Note: Empty wells are those that are flagged with Low ROX, Low
FAM, or Low VIC flags.

Displays the number of wells with low ROX signal.

Displays the number of wells with low FAM™ dye signal.

. Displays the number of wells with low VIC® dye signal (only for

duplex experiments). For singleplex experiments, this column
displays N/A.

Il FI

Displays the number of wells with a FAM™ dye score that is lower
than the threshold value specified in the Analysis settings.

Displays the number of wells with a VIC® dye score that is lower
than the threshold value specified in the Analysis settings (only for
duplex experiments). For singleplex experiments, this column
displays N/A.

The lower half of the Sample Group view displays the plot view and well table. Use
the H, ﬂ, Y. ,and A buttons to extend the views horizontally or vertically.

You can select wells in the plot view or the well table. In the plot view, select wells by
clicking in the plot and dragging a rubber-band box. In the well table, select wells by
selecting the respective rows. Wells selected in the plot view will appear selected in the
well table and vice-versa. In the plot view, selected wells will appear colored, while
unselected wells will be hidden. To view unselected wells, go to View » Show
Unselected. The unselected wells will appear in grey color in the plot view. If no wells
are selected, the plot view displays all the wells in color.

The Plot View includes the following tools:

Tool

Description

Drop-down menu that enables you to select from AR vs. Cycle
(Linear), AR vs. Cycle (Log], R vs. Cycle (Linear), R vs. Cycle (Log],
and ROX vs. Reporter Dye plot types.
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Section 3.1 General Analysis Workflow

(Optional] Perform QC on results data

Tool Description
Drop-down menu that enables you to show and hide the following:
e Crt Range

Note: Crr Range includes two ranges, the positive range and
negative range. The positive range is colored in green in the
Histogram plot. If the well Cry falls within this range, the well
will be called Positive. The negative range is colored red in the
Histogram plot. If the well Cgy falls within this range, the well
will be called Negative.

e Histogram

Note: The Histogram shows the distribution of the Cgy values
for a given Sample Group. Each bar in the Histogram represents
the number of wells whose Cgy values falls between a small
range of 0.1 such as 30.1-30.2.

e No Amplification Bar

Note: The No Amplification Bar counts the number of wells for
undetermined Cry. This option is enabled only when you select
the Histogram option.

e Legend
e Show Unselected
* Cgr
* Show Omitted
Drop-down menu that enables you options to color the plot using
: different data elements. Select Bookmarks, Targets, Wells, or Call.

In addition to the tools mentioned above:

¢ The Targets plot view includes , , , and to zoom in, zoom out, to fit
data in window, and to view data in full screen respectively.

Note: To zoom into a particular area of the amplification plot, click at the center of
the area of interest then click .

¢ C(lick , , and to print, copy, and save the plot as an image respectively.

* C(lick to access and edit the Plot Properties.
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The Plot view for the Sample View tab of an example study is shown in the following

image:
AR vs Cycle (Linear)
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Section 3.1 General Analysis Workflow
(Optional] Perform QC on results data

Adjusting the Cry range

You can hold the cursor over the bars in the Histogram plot to view the positive and
negative Cgy range (the green and red shaded regions in the Amplification Plot or
Histogram Plot).

The initial Cgy range is automatically detected based on the Histogram. However, you
can manually change the Cgy range by dragging the edge of the shaded region to
manually adjust the Cgy range. DigitalSuite™ Software does not allow overlapping of
the positive and negative Cg range. When you manually change the Cgy range, the
value gets updated in the Min Pos Cgy, Max Pos Crp, and Min Neg Cgy columns in the
Analysis Settings dialog box.

P B an b

AR vs Cycle (Linear)

Frequency

Flag Settings

W) Configure this analysis setting for the study.

p
yr
s
b, //
v
4
y
s
s
/4
L
-
2 4 L] 10 12 1 16 18 Fd z ) Fl E] ki X2 3 k] 38 &
Cycle
10 12 1 16 18 Fd z ) F) = ki X2 38 &

CRT

General

Sample Group-Specific Settings

Confidence Interval (%):

//\wmm(u < [0.023

Target Sample

Low Reporter

=
=
=
=)

~

Min Pos CRT | MaxPos C...| Min Neg CRT| Auto? | Low ROX

Tagman Assay 1

DHA Sample 1

27.2

35.2

36.2

180.71

437.85

Tagman Assay 1

DHA Sample 2

27.1

35.1

36.1

383.12

469.75

Tagman Assay 1

NTC

==

5

38

39

359.22

435.13

Reset to Defaults

Alternatively, the threshold values are also available and can be changed directly in the
Analysis settings dialog box (see “Analysis settings” on page 31).

To revert to automatic Cy range:
1. Click Analysis Settings to access the Analysis Settings dialog box.

2. In Sample Group-Specific Settings find the corresponding Sample Group.
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(Optional] Perform QC on results data

3. Select the check box for the Auto column appearing to the right of the Sample

column.
3 Analysis Settings 3]
& Configure this analysis setting for the study.
General
Confidence Interval (%): 95 el Volume (uL): [0.033

Sample Group-Specific Settings

Target Sample Auto? || Min Pos Cr | MaxPos C...| Min Neg Crr| Auto? | Low ROX Low Reporter
Tagman Assay 1 [DHA Sample 1 @ 271 351 36.1 @ 402.38 331.42|
Tagman Assay 1 |NTC = 5 38 29 = 219.57 242.92|
Tagman Assay2 |DNA Sample 1 @ 2538 338 343 @ 402.38 577.04]
Tagman Assay2 NTC @ 5 38 ) @ 219.57 724.04

Adjusting the empty well threshold

You can adjust the empty well threshold in the ROX vs. Reporter Dye plot from the
Plot drop-down menu. The ROX vs. Reporter Dye Plot plots the ROX dye signal on the
X-axis against the Reporter Dye (FAM"" dye or VIC® dye) signal on the Y-axis. The
reporter dye value for a given well is taken from the median value of the first five
cycles for that well.

& view - ¥ Color by: call » 2 L B j‘“hu by = ls‘
L L]
AR ws Cyde (Linear) ROX vs. FAM
AR vs Cyde (Log)
R vs Cyde {Linear) =]
R vs Cycle {Log)
ROX vs Reporter Dye
1,100
1.000 =

=lele]

800

FAM

The empty wells are seen as ‘x” in the ROX vs. Reporter Dye plot, while non-empty
wells as seen as colored boxes. By default, the wells are colored by their Calls.

The grey shaded area on this plot indicates the region containing non-empty wells. The
left edge of the shaded area is the threshold for Low ROX and the bottom edge of the
shaded ares is the threshold for the Reporter Dye.

The initial grey area on the ROX vs. Reporter Dye plot is automatically detected based
on the distribution of all the wells on the plot for the given Sample Group. The wells
that have ROX or reporter signals significantly lower than other wells, will be flagged
as Low ROX, Low FAM or Low VIC accordingly; and subsequently flagged as empty
wells. However, you can adjust the area by manually dragging the lower-left corner of
the shaded area.
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General Analysis Workflow
(Optional] Perform QC on results data

The Threshold values are also available and can be changed in the Analysis settings
dialog box (see “Analysis settings” on page 31).

To revert to the initial Low ROX and Low FAM/Low VIC range:

1. Click Analysis Settings to access the Analysis Settings dialog box.

2. In Sample Group-Specific Settings find the corresponding Sample Group.

3. Select the check box for the Auto column appearing to the left of the Low ROX

column.

W Configure this analysis setting for the study.

J— %

General
Confidence Interval (%):

Sample Group-Specific Settings

Well Volume {uL): [0.033

Target Sample Auto? | Min Pos CRT | MaxPos C... | Min Neg CRT || Auto? | Low ROX Low Reporter
Tagman Assay 1 |DNA Sample 1 27.1 35.1 261 | 402.88 331.42
Tagman Assay 1 |NTC B 38 39 219.57 242.92
Tagman Assay2 |[DNA Sample 1 25.8 33.8 34.8 402.88 677.04
Tagman Assay2 [NTC 5 38 39 219.57 744.04

Reset to Defaults

0K and Analyze

IMPORTANT! For duplex experiments, there is a possibility to see a ‘x” within the grey
shaded area. The ROX vs. Reporter Dye plot displays only one reporter, either FAM™
dye or VIC® dye. In duplex experiments, the same well appears in two sample groups,
one for each reporter dye. Therefore, there is a possibility that the well that appears
within the grey shaded area for one reporter dye can appear outside the grey shaded
area for the other reporter dye. This well will appear with the ‘x’ for both reporter

dyes.
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The Well Table includes the following tools:

Tool

Description

& View -

Drop-down menu that allows you to show or hide columns in a
table. Select or Deselect the following:

e Call
e Call Type
e Bookmark
e Omit
e Empty Well Flag
¢ Empty Type
* Cgr
e Amp Score
¢ Experiment
¢ Flag indicator
¢ Flags
- Low ROX
Low FAM
Low VIC
Low FAM Score
Low VIC Score

Note: Wells with undetermined calls are not flagged for Low
FAM Score or Low VIC Score even if their Amp Score value is
less than threshold.

==

Group by -

Drop-down menu that enables you to group the targets by
experiments or by none. Select from:

¢ None

e Experiment
¢ Expand Al
¢ Collapse All

Note: The Expand All and Collapse All options are enabled only
when Experiment is selected

rl Bookmark -

Drop-down menu that enables you add, select, and clear
bookmarked wells. Select from Add Bookmark, Select all
bookmarks, Clear selected bookmark, Clear all bookmarks

=, Change Cal ~

Drop-down menu that enables you to manually change the call for
a well(s). Select Positive, Negative or Undetermined.

You can also use this drop-down menu to Clear Manual Call, Mark
as Empty Well, Mark as Non-Empty Well, Auto Empty Detection.

Note: When you manually change the call for a well(s), the call will
remain unchanged even after you re-analyze the study.
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The following table provides definitions for the column headings that appear in the
well tables in the Sample View tab:

Column heading

Description

Well Displays the Well location

Call Displays the call in the well (Positive, Negative, or Undetermined)
Note: Positive calls are indicated by 0, Negative calls are
indicated by @, and Undetermined calls are indicated by

Call Type Whether the call is Auto or has been changed manually

Bookmark Indicates if the well is bookmarked

Omit Includes a check box to omit a well

Empty Type Whether the well has been labelled empty automatically or
manually

Crt Crt value for a well

Amp Score Amp Score value for a well

Experiment Name of the experiment to which the target belongs

ﬂ | Flag Indicator. Displays the number of flags in a well

o The icon displayed if the well is flagged with Low ROX
‘ fa ‘ The icon displayed if the well is flagged with Low FAM
‘ e | | The icon displayed if the well is flagged with Low VIC (only for

duplex experiments). For singleplex experiments, this column
displays N/A

The icon displayed if the well is flagged with Low FAM Score

The icon displayed if the well is flagged with Low VIC Score

Note: You can sort the table columns by clicking once on the column header. You can

change the sorting order with a second click. A third click will clear the sorting order.

You can sort the table columns at multiple levels. For example, click the Call column to
sort the columns by Call, then hold down the Ctrl key and click the Ci column to sort
by Cgr the wells with the same call.
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The Well Table view for the Sample Group tab of an example study is shown in the
following image:

% View - ﬁ Group by ~ :I Bookmark ~ ;.‘— Change Call -
# | well| call | call Type N | omit |t} | Empty Type CRT Amp Score Experiment & Ls o 5 F* =t

il ABal 0 Auto | Auto 31.16| 1.45|SingleplexExample.ads 0 N/ A N/A -~
2 ABa2 e Auto O Auto Undetermined 0.00(SingleplexExample.ads 0f /A NJA

3 ABa3 e Auto ] Auto Undetermined 0.64|SingleplexExample.eds 0 N/ A N/A

4 ABa4 0 Auto O Auto 30.15 1.46|SingleplexExample.eds 0 N/ A N/&

5 ABa5 e Auto | Auto Undeterminad 0.00[SingleplexExample.ads 0 N/ A N/A

6 ABa6 e Auto O Auto Undetermined 0.00(SingleplexExample.ads 0f /A NJA

7 ABa7 e Auto ] Auto Undetermined 0.00[SingleplexExample.eds 0 N/ A N/A

B8 ABaB 0 Auto O Auto 31.18) 1.45|SingleplexExample.eds 0 N/ A N/&

9 ABb1 e Auto | Auto Undeterminad 0.00[SingleplexExample.ads 0 N/ A N/A

10 ABb2 e Auto O Auto Undetermined 0.00(SingleplexExample.ads 0f /A NJA

ik Agh3 e Auto ] Auto Undetermined 0.56(SingleplexExample.eds 0 N/ A N/A

12! ABb4 0 Auto O Auto 31.24 1.47|SingleplexExample.eds 0 N/ A N/&

13 ABbS e Auto | Auto Undeterminad 0.00[SingleplexExample.ads 0 N/ A N/A

14 ABbE e Auto O Auto Undetermined 0.00(SingleplexExample.ads 0f /A NJA

15 Agb7 e Auto ] Auto Undetermined 0.00[SingleplexExample.eds 0 N/ A N/A

16 ABb8 e Auto O Auto Undetermined 0.00[SingleplexExample.eds 0 N/ A N/&

17 ABcl e Auto | Auto Undeterminad 0.00[SingleplexExample.ads 0 N/ A N/A

18 ABC2 e Auto O Auto Undetermined 0.00(SingleplexExample.ads 0f /A NJA

19 ABC3 e Auto ] Auto Undetermined 0.00[SingleplexExample.eds 0 N/ A N/A

20 ABcd 0 Auto O Auto 31.32 1.48/SingleplexExample.eds 0 N/ A N/&

21 ABCS e Auto | Auto Undeterminad 0.00[SingleplexExample.ads 0 N/ A N/A

22 ABcE e Auto O Auto Undetermined 0.00(SingleplexExample.ads 0f /A NJA

23 asc €8 [auto [l Autn 1 1.46lSinalenlexFxamnle.ads i Iz /A ~

Replicate Group view

The Replicate Group table lists the targets in the study. The Targets table includes the
following columns:

Column Description

Bookmark Indicates whether a target is present in a bookmarked well

To bookmark a well:

e On the Heat Map screen, select one or more wells in the plate
layout right-click and select Add Bookmark from the drop-down
menu

Or

e On the Amplification Plot screen, in the Well Table, select Add
Bookmark from the Bookmark drop-down menu or from the
right-click drop-down menu

Target | Displays the target name.

Sample | Displays the sample name.

Dilution Displays the dilution for the group.

Copies/pL Displays the number of copies of the sample group per pL.
[+ Displays total number of positive calls.

Note: Positive calls mean the DigitalSuite™ Software determines a
well containing at least one copy of the sample.

[—] Displays total number of negative calls.

Note: Negative calls mean the DigitalSuite™ Software determines
that a well does not contain any copy of the sample.

54 Applied Biosystems OpenArray® Digital PCR Experiments User Guide



Section 3.1 General Analysis Workflow

(Optional] Perform QC on results data

Column

Description

Displays total number of undetermined calls.

Note: Undetermined calls are those that occur between the positive
and negative range as well as beyond the positive range on the
histogram plot.

# of Positive +
Negative (# of
Pos+Neg)

# of Omitted
# of Empty

Displays the combined number of wells having the positive and
negative calls.

Displays the number of wells omitted from the study.
Displays the number of empty wells.

Note: Empty wells are those that are flagged with Low ROX, Low
FAM, or Low VIC flags

Displays the number of wells with low ROX signal.

Displays the number of wells with low FAM™ dye signal.

Displays the number of wells with low VIC® dye signal (only for
duplex experiments). For singleplex experiments, this column
displays N/A.

Displays the number of wells with a FAM™ dye score that is lower
than the threshold value (1.41).

Il FI

Displays the number of wells with a VIC® dye score that is lower
than the threshold value (only for duplex experiments). For
singleplex experiments, this column displays N/A.

The lower half of the Targets view displays the plot view and well table. Use the ﬂ,
ﬂ, v ,and < buttons to extend the views horizontally or vertically.

You can select wells in the plot view or the well table. In the plot view, select wells by
clicking in the plot and dragging a rubber-band box. In the well table, select wells by
selecting the respective rows. Wells selected in the plot view will appear selected in the
well table and vice-versa. In the plot view, selected wells will appear colored, while
unselected wells will be hidden. To view unselected wells, go to View » Show
Unselected. The unselected wells will appear in grey color in the plot view. If no wells
are selected, the plot view displays all the wells in color.

The Plot View includes the following tools:

Tool

Description

(Log) plot types.

Drop-down menu that allows you to select from AR vs. Cycle
(Linear), AR vs. Cycle (Log), R vs. Cycle (Linear], and R vs. Cycle

L]

Legend

* Cgr

¢ Show Unselected

¢ Show Omitted

Drop-down menu that enables you to show and hide the following:
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(Optional] Perform QC on results data

Tool Description
Drop-down menu that enables you options to color the plot using
i different data elements. Select Bookmarks, Targets, Wells, or Call.

In addition to the tools mentioned above:
* The Targets plot view includes , , , and to zoom in, zoom out, to fit

data in window, and to view data in full screen respectively.

Note: To zoom into a particular area of the amplification plot, click at the center of
the area of interest then click .

e C(lick , , and to print, copy, and save the plot as an image respectively.

¢ C(lick =] to access and edit the Plot Properties.

The Plot view for the Replicate Group tab of an example study is shown in the
following image:

AR vs Cycle (Linear)

3,000 +
2,750 4
2,500 4
2,250 4
2,000 4
1.750

1.500 4

IR (Linear)

1.250 4

1.000
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The Well Table includes the following tools:

Section 3.1 General Analysis Workflow
(Optional] Perform QC on results data

Tool

Description

View -

e Call
e Call Type

e Omit

* Cgr

¢ Flags

¢ Bookmark

e Empty Well Flag
¢ Empty Type

e Amp Score
¢ Experiment
¢ Flag indicator

- Low ROX

- Low FAM

- LowVIC

- Low FAM Score
- Low VIC Score

S Drop-down menu that allows you to show or hide columns in a
table. Select or Deselect the following:

Note: Wells with undetermined calls are not flagged for Low
FAM Score or Low VIC Score even if their Amp Score value is
less than threshold.

Group by -

¢ None

e Experiment
¢ Expand Al
¢ Collapse All

Drop-down menu that enables you to group the targets by
experiments or by none. Select from:

Note: The Expand All and Collapse All options are enabled only
when Experiment is selected.

rl Bookmark -

Drop-down menu that enables you add, select, and clear
bookmarked wells. Select from Add Bookmark, Select all
bookmarks, Clear selected bookmark, Clear all bookmarks.

=, Change Cal ~

Drop-down menu that enables you to manually change the call for
a well(s). Select Positive, Negative or Undetermined.

You can also use this drop-down menu to Clear Manual Call, Mark
as Empty Well, Mark as Non-Empty Well, Auto Empty Detection.

Note: When you manually change the call for a well(s), the call will
remain unchanged even after you re-analyze the study.
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(Optional] Perform QC on results data

The following table provides definitions for the column headings that appear in the
tables in the Replicate Group tab:

Column heading

Description

Well
Call

Displays the Well location

Displays the call in the well (Positive, Negative, or Undetermined)

Note: Positive calls are indicated by 0, Negative calls are
indicated by @, and Undetermined calls are indicated by

Call Type

Whether the call is Auto or has been changed manually

Bookmark

Indicates if the well is bookmarked

Omit

Includes a check box to omit a well

Empty Type

Whether the well has been labelled empty automatically or
manually

Crr

Crt value for a well

Amp Score

Amp Score value for a well

Experiment

3|

Name of the experiment to which the target belongs

Flag Indicator. Displays the number of flags in a well

RO
-

The icon displayed if the well is flagged with Low ROX

=
=

LH

The icon displayed if the well is flagged with Low FAM

| The icon displayed if the well is flagged with Low VIC (only for

duplex experiments). For singleplex experiments, this column
displays N/A

The icon displayed if the well is flagged with Low FAM Score

The icon displayed if the well is flagged with Low VIC Score

Note: You can sort the table columns by clicking once on the column header. You can
change the sorting order with a second click. A third click will clear the sorting order.
You can sort the table columns at multiple levels. For example, click the Call column to
sort the columns by Call, then hold down the Ctrl key and click the Ci column to sort
by Cgr the wells with the same call.

58
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(Optional] Perform QC on results data

The Well Table view for the Replicate Group tab of an example study is shown in the
following image:

® View - EG[UUD by ~ :I Bookmark - ;I_ Change Call -
# well| call Call Type ] Omit &) | Empty Type CRT Amp Score Experiment [ e 7 ¥ ¥ i
1 ABal 0 Auto O Auto 31.16| 1.45|SingleplexExample.eds [1] N/A N/A el
2 ABaZ2 e Auto O Auto Undetermined| 0.00|SingleplexExample.eds 1] /A N/ A —
3 ABa3 O Auto O Auto Undetermined| 0.64|SingleplexExample.eds 0| N/A N/A
4 ABad 0 Auto O Auto 30.15] 1.46/SingleplexExample.eds [1] N/ A N/ A
5 ABa5 O Auto O Auto Undetermined| 0.00|SingleplexExample.eds 0| /A /A
6 ABab e Auto O Auto Undetermined| 0.00(SingleplexExample.eds [1] N/A N/A
7 ABa7 e Auto O Auto Undetermined 0.00|SingleplexExample.eds 1] /A N/ A
8 Agag & |auro F Auto 31.18| 1.45/5ingleplexExample.eds 1] MfA N/A
] A8b1 e Auto O Auto Undetermined, 0.00|SingleplexExample.eds [1] /A N/ A
10 Asb2 O Auto O Auto Undetermined| 0.00|SingleplexExample.eds 1] INj A /A
11 ABb3 O Auto O Auto Undetermined| 0.56|SingleplexExample.eds [1] N/ A N/ A
12 ABb4 0 Auto O Auto 31.24] 1.47|SingleplexExample.eds 1] /A /A
13 ABbS e Auto O Auto Undetermined| 0.00|SingleplexExample.eds [1] N/A N/A
14 ABbG e Auto O Auto Undetermined| 0.00|SingleplexExample.eds 1] /A N/ A
15 ABb7 O Auto O Auto Undetermined| 0.00|SingleplexExample.eds 0| N/A N/A
16 ABbS O Auto O Auto Undetermined, 0.00(SingleplexExample.eds [1] N/ A N/ A
17 ABcl O Auto O Auto Undetermined| 0.00|SingleplexExample.eds 0| /A /A
18  ABc2 e Auto F Auto Undetermined| 0.00/SingleplexExample.eds 0 MiA N/A
19 ABC3 e Auto O Auto Undetermined 0.00|SingleplexExample.eds 1] /A N/ A
20 ABc4 0 Auto O Auto 31.32| 1.48|SingleplexExample.eds 0| N/ A N/A
21 ABCS e Auto O Auto Undetermined, 0.00|SingleplexExample.eds [1] /A N/ A
22 ABCH O Auto O Auto Undetermined| 0.00|SingleplexExample.eds 1] INj A /A
23 ARrT £3 [auro [ Auto 1 1.46lSinalenlexFxamnle.eds 0 /A /A M

Flag Summary The Flag Summary screen displays a list of the DigitalSuite'" Software flags; The flag
summary table includes the flag description, and the number of wells, targets, sample
groups, and replicate groups in which the flag occurs for any experiment added to a
study.

The Flag Summary screen for an example study is shown in the following image:

Flag lcon Description # of Wells # of Targets # of Sample Groups # of Replicate Groups
Low ROX 2 |The median of ROX signal (first 5 cycles) is lower than the threshold. 3] 1] 2 2
Low FAM %' |The median of FAM signal (first 5 cycles) is lower than the threshold. 0| 0| 0 0|
Low VIC ‘¥ |The medin of VIC signal (first 5 cycles) is lower than the threshold. 0 0 0 0
Low FAM Score [ |The FAM score is lower than the threshold. 2| 1] 2 2|
Low VIC Score & |The VIC score is lower than the threshold. 0| 0) 0 0)
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Export the analyzed data

Export the analyzed data

Export procedure
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The Export feature of DigitalSuite™ Software enables you to export the analyzed data.

1. Open the study file that contains the data to export, and from the Export
Workflow menu, click E; = Export.

2. Select to export all data in one file or in separate files for each data type.
* One File — All data types are exported in one file.
— If you select the *.csv format, a worksheet is created for each data type.
— If you select the *.txt format, the data are grouped by data type.

* Separate Files — Each data type is exported in a separate file. For example, if
you select all three different data types Amplification, Results - Sample
Group, Results - Replicate Group to export, three separate files (one each for
Amplification, Results - Sample Group, Results - Replicate Group) are
created. You can select the type of file (*.csv or *.txt) to export from the File
Type drop-down menu.

3. (Optional) Select the Open after export check box to automatically open the file
when export is complete.

4. (Optional) Select the Export Bookmark Data only check box to only export
bookmarked wells, sample groups, or replicate groups.

5. Enter a file name and location.
a. Enter a name for the export file in the File Name field.

Note: If you choose to export data in separate files, each file must have a
different name.

b. Enter the Directory where you want the exported file to save. Click Browse if
you do not want to save the export file in the default export folder.
Note: To set up the Export File Location, go to Tools » Preferences, and
select the User-defined location: check box.

6. Select the data to export. Select the check box of the data to be exported.

Tool Function

Amplification data Amplification results, such as Cry values and calls

Note: Results are
reported at a well level

Results - Sample Group | Results by Sample group

Results - Replicate Results by Replicate group
Group

Note: Results data are not available for export until the study is analyzed.

Note: To export Multicomponent Data from digital PCR experiments, use the
Export feature in the QuantStudio™ 12K Flex Software.

7. Click Start Export.
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The Export screen for an example study is shown in the following image:

Section 3.1

General Analysis Workflow
Export the analyzed data

3

Export Data To: (& One File () Separate Files

[] Export Bookmark Data only

[] Open after export

Directory: |C:\Applied Biosystems\DigitalSuite Software\User Files

omit
Experiment
Amp Score
al

Call Type

Select Contents

Empty Type

il Name: [Untitled_20120202_151810_AnalysisResults

[ Resuits - Sample Group | [Z] Resuls - Repicate smuﬂ

‘W Previewing 15 of 3072 rows.

# | Well | Target | Sample | Diution | Empty = Empty Type Omit | Experiment | Amp Score | Cal = Call Type | CRT | Dye
1|Alal |Tagma... DNA Sa... 1|False Auto False |SingleplexE... 1.4080155(Pos... |Auto 29.9... FAM
2|a122 |Tagma...|DNA Sa.. 1|False  |Auto False 1.4303682JPos... [Auto 30.9...[FAM
3|Ala3 (Tagma...|DNA Sa... 1|False Auto False |SingleplexE... 1.4162734[Pos... |Auto 30.8...|FAM
4|Ala4 |Tagma... DNA Sa... 1|False Auto False |SingleplexE... 0.0} Auto und...|FAM
54135 |Taqma...|DNA Sa.. 1|Felse  |auto Fake [SingleplexE... | 1.4143976[Pos...|Auto 30.0...[FAM
6(Ala6 (Tagma...|DNA Sa... 1|False Auto False |SingleplexE... Auto Und...|FAM
7|Ala7 |Tagma...|DNA Sa... 1|False Auto False |SingleplexE... 0.0Ne... |Auto Und...|FAM
8/Al28 |Tagma...|DNA Sa... 1|False Auto False |SingleplexE... 0.0fNe... |Auto und...[FAM
9/A1b1 |Tagma... [DNA Sa... 1|False Auto False |SingleplexE... | 0.4583555] Auto Und...|FAM

10[41b2 |Tagma...|DNA Sa.. 1|False  |Auto Fae [SingleplexE... | 1.4519688[Pos...|Auto 30.2...[FAM

11|A1b3 |Tagma... |DNA Sa... 1|False Auto False |SingleplexE... 1.4289114[Pos... |Auto 30.6...|FAM

12|A1b4 |Tagma... |DNA Sa... 1|False Auto False |SingleplexE... 0.0[Ne... [Auto und...|FAM

13|41b5 |Taqma...|DNA Sa.. 1|Felse  |auto Fake lepl 1 Auto 29.3...[FAM

14|A1b6 |Tagma... |DNA Sa... 1|False Auto False |SingleplexE... 1.4395503(Pos... |Auto 29.3... FAM

15/A1b7 |Tagma... |DNA Sa... 1|False Auto False |SingleplexE... 1.4573503(Pos... |Auto 30.4...|FAM
<

Note: The screenshot displays the export preview. The export preview lists the

first 15 rows of data if there are more than that number. Else, all are displayed.

8. The exported file when opened in Microsoft Excel appears as shown below:

B9t x
Home | Inset  Pagelajout  Formuias  Data  Review  View  Adddns  Acrobat x

& e o |= = ﬂ] ﬁ' ) | = 2 Fgf | = Autosum -
ot Calibri - || [ (-] |SrwrepTen General & B | = @ g

P romatpaner B2 B[O A | e merae o™ A Sl M| (TS0 T e | D O
Clipboard & Font 5 Alignment o Number o styles Cells

[ Al - Jx | #Study Name: Examplestudy2
A s re o 3 £ G H i ) K L m N o 3 a =

1 #Study Name: ExampleStudy2

2 #Description:

3 #Comments:

4% Date/Time Study Modified: 02-02-2012 15:02:30 SGT

5 #Confidence Level:0.95

6 #Wwell Volume (ul):0.033

7_#Sample Group-Specific Settings

s la Target  Sample  Min Pos C Max Pos CMin Neg CLow ROX Low Reporter

s 1Taqman ADNASamy 27.14815 35.14815 36.14815 180.71  437.85

10 2 Tagman ANTC s 38 39 3502206 4351281

1

12

1B Well  Target Sample Dilution Empty EmptyTyfOmit  ExperimeiAmp Scor¢Call call Type CRT Dye

1 1Alal  TagmanADNASamg 1 FALSE Auto FALSE Singleple; 1.408016 Positive Auto 29.95286 FAM

15 2A1a2  TagmanADNASamg 1 FALSE Auto FALSE Singleple: Auto 30.955 FAM

16 3A1a3  TagmanADNASamg 1 FALSE Auto FALSE Singleple: Auto 30.80521 FAM

17 4Alad  TagmanADNA Samg 1 FALSE Auto FALSE Singleples 0 Negative Auto  Undeterm FAM

18 5Ala5  TagmanADNASamy 1 FALSE Auto FALSE Singleples 1.414398 Positive Auto 30.01115 FAM

19 64126 TagmanADNASamg 1 FALSE Auto FALSE Singleple: 0 Negative Auto  Undeterm FAM

20 7A1a7  TagmanADNASamg 1 FALSE Auto FALSE Singleple: 0 Negative Auto  Undeterm FAM

21 8Ala8  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple) 0 Negative Auto  Undeterm FAM

2 9A1b1  TagmanADNASamy 1 FALSE Auto FALSE Singleple; 0.458356 Negative Auto  Undeterm FAM

2 10A1b2  TagmanADNA Samy 1 FALSE Auto FALSE Singleple; 1.451969 Positive  Auto 30.29071 FAM

2 11A1b3  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple: 1.429911 Po Auto 30.66335 FAM

2 12 A1b4  Tagman ADNA Samy 1 FALSE Auto FALSE Singleples 0 Negative Auto  Undeterm FAM

2% 13A1b5  Tagman ADNA Samy 1 FALSE Auto FALSE Singleples Auto 29.32548 FAM

27 14 A1b6  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple: Auto 29.38301 FAM

3 15A1b7  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple: Auto 30.45614 FAM

2 16 A1b8  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple) Auto 3110242 FAM

30 17Alcl  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple) Auto 29.77832 FAM

e 18AlLc2  Tagman ADNA Samy 1 FALSE Auto FALSE Singleples Auto 3108247 FAM

S 19Alc3  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple: Auto 3111062 FAM

33 2 Aled  Tagman ADNA Samg 1 FALSE Auto FALSE Singleples 0 Negative Auto  Undeterm FAM

3 21Alcs  Tagman ADNA Samy 1 FALSE Auto FALSE Singleples 1.45068 Positive Auto 29.31733 FAM

ES 22416 Tagman ADNA Samy 1 FALSE Auto FALSE Singleple: 14372 Po 30.20806 FAM

E 2317 Tagman ADNA Samy 1 FALSE Auto FALSE Singleple; 0.568827 Negative Auto  Undeterm FAM

37 24 A8 Tagman ADNA Samy 1 FALSE Auto FALSE Singleple) 1.428754 Positive  Auto 30.99615 FAM

38 25A1d1  Tagman ADNA Samy 1 FALSE Auto FALSE Singleple; 1.426528 P Auto 30.56445 FAM

A4 b vi| ExampleStudy?_20120202 173453 A <73 AN ST il — m

Reagy |
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Supporting features

Supporting features

Preferences

Poisson Calculator

62

Use the Preferences dialog box to set the default location and additional study
properties such as display format.

To access the Preferences dialog box, go to Tools » Preferences.

Note: You must close all open studies before adjusting the Preferences settings.

In the General tab, change the default location of the *.eds file and display format for
date, time, and numeric separator format.

1.

Select User-defined location:, and browse to the desired location on your
computer.

To use the default location, select Last-accessed location.

IMPORTANT! If you select the Last-accessed location option and use DigitalSuite™
Software to access an external data storage device, make sure the device is
connected to your computer until you close the application.

Select the date format from the Date Format drop-down menu.
Select the time format from the Time Format drop-down menu.

Select the numeric separator format from the Numeric Separator Format drop-
down menu.

Click OK.
hz" e

‘W) Set the default Save location and additional study properties in this window. &‘

Erences

General

Default Home Location:

(® User-defined location:

C:\Applied Biosystems\DigitalSuite Software\User Files | ’ Browse ]

(O Last-accessed location

Display Format

Date Format: !MM-dd-yyyy v|
Time Format: |24-h0ur format v|
MNumeric Separator Format: |Decima| (1,234.56) v|

Use the Poisson Calculator dialog box to calculate the copies/uL, lower confidence, and
upper confidence for a set of manually entered parameters.

To access the Poisson Calculator dialog box, go to Tools » Poisson Calculator.

1.
2.

Enter the total number of replicates.

Enter the number of negatives.
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Section 3.1 General Analysis Workflow

3. Enter the confidence interval in percent.

4. Enter the well volume in uL.
5. Click Calculate.

Poisson Calculator

Input

Total Replicates:

Mumber of Negatives:
Confidence Interval (%)
Well Volume (uL): |0.033

X

‘W) Enter the total number of replicates and negative calls

Results

Copies/uL: I:I
Lower Confidence: I:I
Upper Confidence: I:I
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Section 3.2  Analyzing Singleplex Experiments

About Singleplex experiments

Section 3.2 Analyzing Singleplex Experiments

In this section, you use the example singleplex experiment file provided with the
DigitalSuite™ Software to create a study and analyze the digital experiment results.
This section includes:

About Singleplex experiments . . .............. i 65
Setup asingleplexstudy ........... ... ... 65
Create astudy ... 65
Define study properties. .. .............uuu 65
Setup plate layout. ............ ... 66
Setup samples and targets. . ......... ... .. i 67
Analyzethestudy......... ... . 68
RUn QC . .o e 71
Heat Map ... ..o 71
Amplification Plot ........ ... 72
Flag Summary. . ... 74
ExporttheStudy. ... ... ..o 75

About Singleplex experiments

Singleplex experiments use FAM'" dye as the only reporter dye.

Setup a singleplex study

Create a study

Define study
properties

Setup a study using the singleplex example experiment from the software installation.

M LN

. Launch DigitalSuite Software, and on the Home screen click Create Study.

In the Import dialog box, navigate to C:\ Program Files\ Applied
Biosystems\ DigitalSuite Software\ examples and select SingleplexExample.eds.
Click Import.

Note: This is a single experiment singleplex study. While setting up your own
singleplex study, you can add multiple singleplex experiments to a study.
Click Properties from the Setup menu to access the Properties screen.

Enter the study name ExampleStudy:.

In the Description field, enter Singleplex example study.

In the Comments field, enter any comments, then click Add.
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Setup a singleplex study

Study Properties

5.

Verify that the Study contents and History Summary match those of your
singleplex example study.

The Properties screen of the singleplex example study is shown in the following image:

Study Name: |Examp\25tudy

Study contents
Experiments in Study: 1
Targets in Study: 1
Samples in Study: 1
History Summary

Created on: 02-06-2012 10:25:33 5GT
Last Modified on:

Description |singleplex example study

Comments:

Setup plate layout

66

-_

Click Plate Setup from the Setup menu to access the Plate Setup screen.

Click Load Plate Template to load the plate setup contents from the example
plate setup file.

Browse to C:\Program Files\ Applied Biosystems\ DigitalSuite
Software\ examples. Select SingleplexExamplePlateSetup.csv.

Note: For your own singleplex studies, you can setup the plate contents using a
previously created plate setup file or click Assign to assign the plate contents. For

more information on assigning plate contents, see “Set up plate layout” on page
25.

Click Show to show or hide the data elements in the plate.
Click Color by: to color the sub-arrays using the different data elements.

Click Legend to show or hide the plate layout legend.
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Setup a singleplex study

The Plate Setup screen of the singleplex example study is shown in the following
image:

Manage Experiments

= Import | == Delete

By Generste pite Template B4 | oad Piste Template

File Name
SingleplexExample.eds

Barcode
[Fae3

Date Added Comments
|p2-06-2012 10:25:58 S6T |

Plate Setup for: SingleplexExample.eds

Leg

% Assign I % show - y Color by: Sample -| Legend
1 z 3 4

{. DNA Sample 1 (2,816)

W niTC (256)

[[] BBk wel (0) |

Setup samples and

targets

Use this screen to add samples and target names, and dilutions, in addition to the

default ones. The names and dilutions will then appear in the Well Editor in the Plate
Setup screen and can be used to set up the plate.

1.
2.

Click Samples/Targets from the Setup menu to access the Samples/Targets screen.

Click Add to add sample names. You can also click in the Name column to change
the default sample name. Optionally, select a color from the Color drop-down
menu.

Note: DigitalSuite™ Software automatically assigns the number of wells for the
sample name.

Click Add to add target names. You can also click in the Name column to change
the default target name. Optionally, select a color from the Color drop-down
menu.

Note: DigitalSuite™ Software automatically assigns the number of wells for the
target name.

Click Add to add dilutions. You can also click in the Dilution column to change
the default dilutions. Optionally, select a color from the Color drop-down menu.

Enter the dilution factor for the dilution.
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Analyze the study

The Samples/Targets screen of the singleplex example study is shown in the following

image:
s Add | wm Delete o Add | me Delete | Diution Factor:

Name Color Comments # of Wells Dilution Fold Color
DN Sample | ~| || 2,816 il 1ﬁ
NTC E ~| 1l 256 0.1 10 v
0.01 100 ~
1E4 1E4 -
o Nl v
0.5 2 v

0.25 4 v
0.125 8 b

Manage Targets

s Add | - Delete
Name Reporter Color Comments # of Wells
Tagman Assay 1 | [ram vE ~| \ | 3,072

Analyze the study

Once you have set up the plate, click Analyze. To modify the analysis settings, click
Analysis Settings.

The Analysis Settings dialog box for a singleplex example study is shown in the
following image:

¥ Analysis Settings

‘W) Configure this analysis setting for the study.

Flag Settings

General
Confidence Interval (2%): well Volume (uL): |0.0323
Sample Group-Specific Settings
Target Sample Auto? | Min Pos CRT | MaxPos CRT Min Neg C... | Auto? | Low ROX Low Reporter
Tagman Assay 1 |DNA Sample 1 27.1 35.1 36.1 180.71 437.85
Tagman Assay 1 [NTC 5 38 39 359.22 435.13

Reset to Defaults

OK and Analyze ] [Canoe\ ]
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Analyze the study

View digital PCR Clicking on the Analysis button automatically takes you to the Digital PCR screen.
results Alternatively, click Digital PCR from the Results Workflow menu to access the screen.

The Confidence Interval value is displayed in the Title Bar of the Digital PCR screen.

Sample Group view

1. Click the Sample Group tab to view the sample group results.
For TagMan® Assay 1, the Copies/uL is 41.2.

2. View the lower confidence (38.9), upper confidence (43.8) values, number of
positive (1,184), negative (1,629), and undetermined (3) calls, total number of
positive and negative calls (2,813), number of omitted wells (0), and number of
empty wells (0).

3. For the Sample Group, NTC the Copies/uL is NA. This is because the number of
positive calls for NTC is 0 and the DigitalSuite™ Software cannot calculate the
Copies/uL.

4. View the corresponding plot in the lower half of the screen.

5. From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot
type displays the Sample Group on the x-axis and Copies/uL on the y-axis.

6. From the View drop-down menu, select Legend.
7. From the Color by: drop-down menu, select Target (default).

The Sample Group view for the singleplex example study is shown in the following
image:

Digital PCR - 95% Confidence Interval

Replicate Group

# Target Sample Copies/uL “* | Lower Conf Upper Conf 0 e # of Pos+Neg # of Omitted # of Empty
1 Taqman Assayl [DNASample1 | 41.2| 38.9| 438 1,184 1,629 3 2,813 0| 0
2 Tagman Assayl |NTC | /4] /4] /A 0 254 0 254| o] 2

VA

\5§Plot:LinearAx's-\ V\e\.’l-ﬂCo\arbv:Targetv o P g % Lfg] g E‘
45
40
35
30

25

Capiesiul

Tagman Assay 1
DNA Sample 1

Sample Group

{. Tagman Assay 1 (1) T 95% Confidence Interval
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Analyze the study

Digital PCR - 95% Confidence Interval

Repiicate Group.

Note: For TagMan® Assay 1, there are 3 undetermined calls. To investigate these 3
calls, go to the Run QC.

Replicate Group view

1.

5.
6.

Click the Replicate Group tab to view the sample group results.

For TagMan® Assay 1, having dilution 1, the Copies/uL is 41.8. The Copies/uL
should be roughly proportional to the dilution series. For example, dilution 0.5 is
half of dilution 1 then the Copies/uL for dilution 0.5 should be roughly half of that
for dilution 1. In the example study, the Copies/uL for dilution 0.5 is 19.5 which is
approximately half of 41.8.

Note: Life Technologies recommends you to check if the Copies/uL results are
always roughly proportional to the dilution series. If the ratio of Copies/
pL:dilution is significantly different in the Replicate Groups, check the plate setup
or re-run the experiment.

For TagMan® Assay 1, having dilution 1, view the lower confidence (38.1) and
upper confidence (45.8) values, number of positive (526), negative (177), and
undetermined (1) calls, total number of positive and negative calls (703), number
of omitted wells (0), and number of empty wells (0).

View the corresponding plot in the lower half of the screen.

From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot
type displays the Replicate Group on the x-axis and Copies/pL on the y-axis.

From the View drop-down menu, select Legend.

From the Color by: drop-down menu, select Target (default).

The Replicate Group view for the singleplex example study is shown in the following
image:

#

Target Sample Dilution | Copies/ul | Lower Conf | Upper Conf [+] (-] # of Pos+Neg | #of Omitted | # of Empty
Tagman Assay 1 |DNA Sample 1 1 41.8| 38.1 45.8| 526 177] 1] 703] 0 0)
Tagman Assay 1 [DNA Sample 1 0.5 19.5| 17.5] 21.8 334 369 1] 703] 0 0]
Tagman Assay 1 [DNA Sample 1 0.25] 10.4} 9.09 12.0] 205| 499 0| 704] 0 0|
Tagman Assay 1 [DNA Sample 1 0.125| 5.62| 4.69| 6.73 119 584 1] 703 0 0|
Tagman Assay 1 [NTC 0 /A N/A| /A 0 254 0) 254 0 2]

1
2
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5
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Run QC

Run QC

Heat Map 1. Go to Run QC » Heat Map to access the Heat Map screen.
2. In the Experiments view, select SingleplexExample.eds.

3. View the corresponding Heat Map in the lower half of the screen.

Note: The VIC button appears disabled for singleplex experiments.
4. Roll-over a sub-array. The tool-tip displays the well contents.

5. From the Show drop-down menu, select Flag to display flags in the heat map.
a. Look out for flagged wells or empty wells.

b. Check the location of these wells in the plate. If the location does not appear
to form any pattern, check the amplification curve in the amplification plot.
Based on these assessments, you can decide to manually change the call or
omit the well.

c. Click Analyze to re-analyze the study.

6. From the Color by: drop-down menu, select Call to display the wells by the color
of the Call.

7. Click Legend to show or hide the plate legend.

The Heat Map for the singleplex example study is shown in the following image:

n File Name Barcode ““X‘ ""‘ = | P | Il‘
SingleplexExample.eds |FQK23 | Z‘ El‘ U| 2| El‘

Heat Map for: SingleplexExample.eds

‘ S Show ~ g Color by: call - Omission

I positive (1,183) M iegative (1,883) B Undetermined (3) X Empty Well (2) > omitted (1)
[ Blank well (0) /\ Flagged (4) [1 Bookmark (0)
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Amplification Plot 1.

Chapter 3 Analyze Experiment Results using DigitalSuite™ Software

Run QC

o g M LD

Go to Run QC » Amplification Plot to access the Amplification Plot screen.

In the Targets view, select TaqMan® Assay 1.

View the corresponding Amplification Plot in the lower half of the screen.

From the Plot drop-down menu, select AR vs Cycle (Linear) (default).

From the View drop-down menu, select Cry to display the Cgry icons on the plot.

From the Color by: drop-down menu, select Call to display the plot by the color
of the Call.

The Amplification Plot - Targets tab for the singleplex example study is shown in the
following image:

Amplification Plot
i Target Sample Group Replicate Group
# N | Target (3 | Fara | vic ‘ s | [
1 Tagman Assay 1 [ 2 i Al T
VA .
=¥ plot - ® view - w Color by iyl ‘.-:.- ,i‘ﬁ_i.l [E=) g E‘ : & view - E=Group by - rl Bookmark - =, Change Cal -
AR vs Cycle (Linear # well call Call Type [] Omit lE) Empty Type CRT
yele ( ) 1 Alal @ |auto O Auto ~
a7e 2 Ala2 @ [auto [ Auto B
3,500 3 Ala3 @ |Auto O Auto
4 Alad @ |auto O Auto Undetel
3250 5  AlaS @ [auto [ Auto
2000 6 Al @ [auto [ Auto Undeter
7 Ala7 @ |auto O Auto Undetel
2750 8 Alag @ |auto O Auto Undeter
9 Albl @ |auto O Auto Undetel
2,500
10 Abz @D [aute [ Auto
2280 11 Alb3 @ |auto O Auto
= 12 Alb4 @ |auto O Auto Undetel
2 2000 i1z abs @ [aur ] Auto
2 1780 14 AlbE @ |auto O Auto
E 15  Alb7 @@ |Auto ] Auto
500 16 Alb8 @D [auto [ Auto
1,250 17 Alcl @ |auto O Auto
18 Al @ |auto O Auto
1000 19 AlcG @ [auto [ Auto
780 20 Alc @ |auto O Auto Undeter
21 Al @ |auto O Auto
500 22 Al @ [auto O Auto
23 Al @ |auto O Auto Undeter
=0 24 Al @ |auto O Auto
o 25 Aldl @ [auto O Auto
26 Ald2 @ |auto O Auto Undeter
27 mdz @ lauto [ Auto Undete ¥
< | >
7. In the Sample Group view, select TagMan® Assay 1.
8. View the corresponding Amplification Plot in the lower half of the screen.
9. From the Plot drop-down menu, select AR vs Cycle (Linear) (default).
10. From the View drop-down menu, select Cgy Range and Histogram to display the
Cgr range and the Histogram on the plot.
11. From the Color by: drop-down menu, select Call to display the plot by the color
of the Call.
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Run QC

The Amplification Plot - Sample Group tab for the singleplex example study is shown
in the following image:

Amplification Plot
p Replicate Group
# | N | Target Sample Copies/uL 1] @ Pos + Neg Omitted Empty (e e s [F* [
1 Tagman Assay 1 [DNA Sample1 | 310 1183 1692 3 2,875 1 1| 1 0 H/A 2 H/A
3% | Tagman Assay 1 |NTC | /A 0| 191 0| 191] o] 1| 1 1 /A /A
WA P,
|g§p\nt = N w Color by: Call - /® p Ff; % ﬂ‘al [~ lE‘ z ®  View - EGFDUD by ~ :I Bookmark - :7 Change Call ~
AR vs Cvcle (Linear # | well| call | call Type A | omit el | Empty
3750 yele ( ) 1 Alal @ |auto O lAuto &
S 2 Ata2 @ |auto [} e —
3,250 3 Ala3 & [auto [H] lauta
3,000 4 Alad @ |Auto O |Auto
2,750 3 Ala5 @ |auto ] |Auto
2,500 6 Alab @ [auto O lAuto
= 2250 7 Ala7 @ |nuto [] lAuto
Soaan 8  Alag @ |auto [} lAuto
ik oAbl @ |Aute ] lAuto
< 1 10 Alb2 @ |Auto O lAuto
1,250
e 11 A1b3 @ |auto [ lAuta
e 12 Albs | @ [Auto [l lauto
500 ijla  A1bs @ |auto O |Auto
250 14 Alb6 @ |auto O |Auto
0 15 Alb7 @ [auto O [Auto
2 4 ] a 10 12 14 16 1@ 16 Albs 0 Auto D Auto
17 Ald @ |auto [ lAuta
18 AlQ @ [auto O lAuto
= 19 AlG & |Auto [] lAuto
200 20 Alcd @ |auto O lAuta
5 21 Alcs @ |Aute ] lauto
5 190 22 Alce @ |Auto ] [Auto
£ 00 23 Al @ |aute [} lAuto
. 24  Alc @ [auto O lAuto
50 25  Aldl & |Auto [] lAuto
26 Ald2 @ |auto O lAuta
0 2 4 & a 10 12 1“4 16 1@ 20 2 24 2 28 a0 a2 £ k] k] &0 127 Ald3 e \Auto I:l |Auto A
CRT 5
12. In the Replicate Group view, select TaqMan® Assay 1.
13. View the corresponding Amplification Plot in the lower half of the screen.
14. From the Plot drop-down menu, select AR vs Cycle (Linear) (default).
15. From the View drop-down menu, select Cgy to display the Crr icons on the plot.
16. From the Color by: drop-down menu, select Call to display the plot by the color

of the Call.
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Run QC

Amplification Plot

Target Sample Group

# R | Target Sample
Tagman Assa...|DNA Sample 1

Dilution Copies/ulL 1] -] Pos + Neg Omitted | Empty (e i e & &t

The Amplification Plot - Replicate Group tab for the singleplex example study is
shown in the following image:

25.0 610 473 1,085 /A

Tagman Assa...|DNA Sample 1

19.5 334 36| 703 /A

Tagman Assa...|DNA Sample 1

10.8| 134 314] 448| H/A|

Tagman Assa...|DNA Sample 1

0.125 2.44 105 234

639| H{A|

ORI

Tagman Assa...[NTC

=1 =1 I
olo|o|o|m
mlololale
—lolo|o|m
mlololalo
olo | ool

=

=

=

/A 0 191 191 /A

WA

3,500

3,250

3,000

2,750

2,500

2,250

2000

1750

AR (Linear)

1,500

1250

1,000

750

500

250

“—_é Plot - . View - M Color by: Call -

AR vs Cycle (Linear)

/@ /@ :'_:.: i:i_i “—E] \g lE‘ : . view - EGmup by - :I Bookmark ~ :7 Change Call =
# Wwell Call Call Type n Omit e Empty Type
Alal Auto O Auto
Ala2 Auto O Auto
Ala3 Auto Auto
Alad Auto Auto
Ala5 Auto Auto
Alab Auto Auto
Ala7 Auto Auto
Ala8 Auto Auto
Albl Auto Auto
10 Alb2 Auto Auto
i Alb3 Auto Auto
12 Alb4 Auto Auto
il13 Abs Auto Auto
14 Alb6 Auto Auto
15 Alb7 Auto Auto
16  Albs Auto Auto
17 Ald Auto Auto
18 Alc2 Auto Auto
o Al Auto Auto
20 Alct Auto Auto
21 Alcd Auto Auto
22 Alco Auto Auto
23 Alc7 Auto Auto
24
25

|

(1= - TN - T R STV R

AlcB Auto Auto
Aldl Auto Auto
26 Ald2 Auto Auto

0000000000000 0000000000000
OgocooOoOoooDoooooooooooooO.

27 Ald3 Auto Auto
Cycle < >

[I£3

Flag Summary
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In the singleplex example study, there are 3 undetermined wells when the study is

analyzed with the default analysis settings. You can review the amplification curve for
these three wells and after assessing the amplification curves, you can decide whether
you want to adjust the Cgy range, manually change the call, or omit the well altogether.

Tips for viewing the Amplification Plot for your own study

e Sort the undetermined calls by clicking on the Call column header in the Well
Table so that you can select all the undetermined calls quickly and review the
respective amplification curves.

¢ Sort the flagged wells by clicking on the 4 column header or the individual flag
column header in the Well Table so that you can select flagged wells quickly and

review their amplification curves.

e After assessing the individual amplification curves, you can decide whether you

want to adjust the Cgr range, manually change the call, or omit the well
altogether.

¢ To view the updated results, you must re-analyze the study after making any of
the above changes.

1. Go to Run QC » Flag Summary to access the Flag Summary screen.

2. View the Flag Summary table.
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Section 3.2  Analyzing Singleplex Experiments

Export the Study

3. View the number of wells in which the flags Low ROX, Low FAM, Low VIC, Low
FAM Score, and Low VIC Score appear.

4. In the singleplex example study, the Low ROX and Low FAM score flags occur in
two wells each. To view the location of the flagged wells, go to Run QC » Heat

Map.

The flagged wells are displayed with a triangle in the well. For the example study,
the flagged wells are also empty wells. Therefore the wells also contain a ‘x” along
with the triangle.

The Flag Summary for the singleplex example study is shown in the following image:

Description

The median of ROX signal (first 5 cycles) is lower than the threshold.

# of Wells

# of Targets

# of Sample Groups

# of Replicate Groups

Low FAM

G

The median of FAM signal (first 5 cycles) is lower than the threshold.

Low VIC

The median of VIC signal (first 5 cycles) is lower than the threshald.

Low FAM Score

The FAM score is lower than the threshold.

Low VIC Score

[EAEARE

The VIC score is lower than the threshold.

olm|ololm

1]
0|
0|
1
0|

ol=|lolol~

olmlolol~

Export the Study

1. From the Export Workflow menu, click Export.

©® N o a M~ w b

Select One file.

Click Start Export.

Applied Biosystems OpenArray® Digital PCR Experiments User Guide

Select the Open after export check box.

Select .csv from the File Type drop-down menu.

Click Browse to select the directory and location to save the exported file.

Enter the file name SingleplexExampleStudy_Export for the exported file.

Select the Results - Sample Group tab to export the Sample Group results.
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Export the Study

The Export screen for the singleplex example study is shown in the following image:

Export Data To: (3) One File () Separate Files [] Export Bookmark Data only pen after export
Directory: ‘C:\Apphed Biosystems\DigitalSuite Software\User Files | Fie Name: |SingleplexExample Study_Export | File Type:

m Resuits - Sample Group T Results - Replicate Group ]

Select Contents @ Previewing 15 of 3072 rows.
#
" # | wel | Target Sample Dilution | Empty = Empty Type | Omit | Experiment Amp Score | Call call Type | CRT Dye
Target 1|Alal |Tagman Assay 1 [DMA Sample 1 1|False Auto False  |SingleplexExample.eds | 1.4080155/Positive  |Auto 29.952858|FAM
Sample 2|Ala2 |Tagman Assay 1 |DMA Sample 1 1|False Auto False  |SingleplexExample.eds 1.4303682[Positive  (Auto 30.9550018|FAM
BRARK) 3|A123 |Tagmen Assay 1 |DNA Sample 1 1lFalse  |auto Fabe [SingleplexBxample.eds | 1.4162734|positive |Auto 30.8052139[FAM
Empty
P 4|Ala4 |Tagman Assay 1 [DNA Sample 1 1|False Auto False |SingleplexExample.eds 0.0[Negative |Auto Undetermined|FAM
omit 5|A1a5 |Tagman Assay 1 |DNA Sample 1 1|False Auto False |SingleplexExample.eds | 1.4143976|Positive  |Auto 30.0111504|FAM
Experment 6|A1a6 |Tagman Assay 1 |DNA Sample 1 ilFale  |Auto False |SingleplexExample.eds 0.0[Negative [Auto Undetermined|FAM
Amp Score
a 7|a1a7 |Tagman Assay 1 |[DNA Sample 1 1Fake  |Auto False  |SingleplexExample.eds 0.0[Negative [Auto Undetermined|FAM
call Type 8|a128 |Tagman Assay 1 |DNA Sample 1 1lFabe  |Auto False  |SingleplexExample.eds 0.0[Negative |Auto Undetermined|FAM
9|A1b1 |Tagmen Assay 1 [DNA Sample 1 1|Fakse Auto False  |SingleplexExample.eds |  0.4583555(Negative [Auto Undetermined|FAM
10{A1b2 |Tagman Assay 1 [DNA Sample 1 1|False Auto False |SingleplexExample.eds | 1.4519688|Positive |Auto 30.2907085|FAM
11|A1b3 |[Tagman Assay 1 [DNA Sample 1 1(False Auto False |SingleplexExample.eds | 1.4299114f Auto 30.6633472|FAM
12|A1b4 |Tagman Assay 1 [DNA Sample 1 1|False Auto False  |SingleplexExample.eds 0.0[Negative |Auto Undetermined|FAM
13|A1b5 |Tagman Assay 1 [DNA Sample 1 1|False Auto False |SingleplexExample.eds | 1.4469665|Positive  |Auto 29.3254795|FAM
14|A1b6 |Tagman Assay 1 |DMA Sample 1 1|False Auto False  |SingleplexExample.eds 1.4395503Positive  [Auto 20.3830147|FAM
15|A1b7 |Tagman Assay 1 [DNA Sample 1 1|False Auto False |SingleplexExample.eds | 1.4573503{Positive |Auto 30.4561385|FAM
<
The exported file when opened in Microsoft Excel is shown in the following image:
Op) 9 s rt.csv - Microsoft Excel a0
a
Home | Inset  Pagelayout  Formulas  Data  Review  View  Adddns  Acobat @ - = x
5 [EP - = ¥ || = FE- || T Autosum -
Calibri -n -A X S wrap Text General - i:‘ll [ £om ﬂ
Dty I O I E s s #
Paste [ T 7 o Meroe A Centens = <3 98| | Conditional Format Cell || Insert Delete Format Sort& Find &
- Jf Format Painter U0 -A = e erge et | i i Formatting ™ as Table ~ Styles™ ||+~ - || 2 e selec
Clipboard ] Font & Alignment = Number o Styles calis Editing
( A1 - @ e | #tudy Name: Examplestudy
A B G D E F 6 H ! 4 K L M N o P

# Study Name: ExampleStudy

i
2 #Description:

3 % Comments:

4 |#Date/Time Study Modified: 02-03-2012 14:02:15 SGT
5 |#Confidence Level: 0.95

6 #Well Volume (ul): 0.033

7 #5Sample Group-Specific Settings

8
)

# Target  Sample  Min Pos C Max Pos CMin Neg CLow ROX Low Reporter
1 Tagman A DNA Samg 27.15805 35.15805 36.15805  180.71  437.85
10 2 Tagman A DNA Samg 27.08193 35.08193 36.08193 383.1176 469.7534
1 3 Tagman A NTC 5 38 39 359.2206 435.1281
12
13
14 4 Well  Target Sample Dilution Empty Empty TyrOmit  ExperimeiAmp ScoreCall Call Type CRT Dye
15 1Alal  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1408016 Positive Auto 29.95286 FAM
16 2Ala2  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1430368 Positive Auto 30.955 FAM
17 3Ala3  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1416273 Positive Auto 30.80521 FAM
18 4A1a4  Tagman ADNA Samg 1 FALSE Auto FALSE Singleple: 0 Negstive Auto  Undeterm FAM
19 5Ala5  Tagman ADNA Samg 1 FALSE Auto FALSE Singleple; 1414398 Positive Auto 30.01115 FAM
20 6Ala6  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple: 0 Negstive Auto  Undeterm FAM
21 7Ala7  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple: 0 Negstive Auto  Undeterm FAM
2 8Ala8  Tagman ADNA Samg 1 FALSE Auto FALSE Singleple: 0 Negstive Auto  Undeterm FAM
23 9 A1bl  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 0.458356 Negative Auto  Undeterm FAM
24 10 A1b2  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1451969 Positive Auto 30.29071 FAM
25 11 A1b3  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1429911 Positive Auto 30.66335 FAM
26 12 A1b4  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple: 0 Negstive Auto  Undeterm FAM
7 13 A1bS  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1446967 Positive Auto 29.32548 FAM
28 14 A1b6  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1.43955 Positive Auto 29.38301 FAM
29 15 A1b7  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1.45735 Positive Auto 30.45614 FAM
30 16 A1b8  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1433281 Positive Auto 31.10242 FAM
31 17 A1l Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1421096 Positive Auto 29.77832 FAM
32 18 A1c2  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1454766 Positive Auto 31.08247 FAM
33 19 A1c3  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1436168 Positive Auto 31.11062 FAM
34 20 Aled  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple: 0 Negstive Auto  Undeterm FAM
35 21 A1c5  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1.45068 Positive Auto 29.31733 FAM
36 22 Alc6  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 14372 Positive Auto 30.20806 FAM
37 23 A1c7  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 0.568827 Negative Auto  Undeterm FAM
38 24 A1c8  Tagman A DNA Samg 1 FALSE Auto FALSE Singleple; 1428754 Positive Auto 30.99615 FAM
R4+ | SingleplexExam dy_Export <73 AT e Sl — m
Ready
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About Duplex experiments

Section 3.3 Analyzing Duplex Experiments

In this section, you use the example duplex experiment file provided with the
DigitalSuite™ Software to create a study and analyze the digital experiment results.
This section includes:

B About Duplex experiments. .. ...t 77
B Setupaduplexstudy......... ... ... 77
Create astudy ...... ..o 77
Define study properties. .. .............uuu 77
Setup plate layout. ............ ... 78
Setup samples and targets. . ......... ... .. i 79
Analyzethestudy......... ... .. 80
RUn QC . .o e 83
Heat Map ... ..o 83
Amplification Plot ........ ... 84
Flag Summary. . ... 87
B ExporttheStudy........ ... i 88

About Duplex experiments

Duplex experiments include two TagMan® Assays using FAM™ dye and VIC® dye as
the reporter dyes respectively.

Setup a duplex study

Setup a study using the duplex example experiment from the software installation.

1 ™

Create a study . Launch DigitalSuite = Software, and on the Home screen click Create Study.

2. In the Import dialog box, navigate to C:\Program Files\ Applied
Biosystems\ DigitalSuite Software\ examples and select DuplexExample.eds.
Click Import.

Note: This contains duplex data from a single OpenArray® plate. When setting
up your own Duplex study, you can add duplex data from multiple OpenArray®
plates to the study.

Define study 1. Click Properties from the Setup menu to access the Properties screen.

properties 2. Enter the study name D ExampleStudy.
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Setup a duplex study

Study Properties

In the Description field, enter Duplex example study.
In the Comments field, enter any comments, then click Add.

Verify that the Study contents and History Summary match those of your duplex
example study.

The Properties screen of the duplex example study is shown in the following image:

Study Name: ‘D Example Study

| Description | puplex example study

Study contents
Experiments in Study: 1
Targets in Study: 2
Samples in Study: 2
History Summary
Created on: 02-07-2012 10:18:17 5GT
Last Modified on: 02-07-2012 10:41:40 SGT

Comments:

Setup plate layout

78

-_—

Click Plate Setup from the Setup menu to access the Plate Setup screen.

Click Load Plate Template to load the plate setup contents from the example
plate setup file.

Browse to C:\Program Files\ Applied Biosystems\ DigitalSuite
Software\ examples. Select DuplexExamplePlateSetup.csv.

Note: For your own duplex studies, you can setup the plate contents using a
previously created plate setup file or click Assign to assign the plate contents. For
more information on assigning plate contents, see “Set up plate layout” on page
25.

Click Show to show or hide the data elements in the plate.
Click Color by: to color the sub-arrays using the different data elements.

Click Legend to show or hide the plate layout legend.
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Setup a duplex study

The Plate Setup screen of the duplex example study is shown in the following image:

Manage Experiments

== Import | == Delete 8 Generate Plate Template i) Load Plate Template

File Name Barcode Date Added Comments
DuplexExample.eds |Pwezo [02-06-2012 1545145 56T |

Plate Setup for: DuplexExample.eds

% Assign I % show - # Color by: Sample . Legend \@% \C& JZE Ek @

Setup samples and  Use this screen to add samples and target names, and dilutions, in addition to the
targets default ones. The names and dilutions will then appear in the Well Editor in the Plate
Setup screen and can be used to set up the plate.

1. Click Samples/Targets from the Setup menu to access the Samples/Targets screen.

2. Click Add to add sample names. You can also click in the Name column to change
the default sample name. Optionally, select a color from the Color drop-down
menu.

Note: DigitalSuite™ Software automatically assigns the number of wells for the
sample name.

3. Click Add to add target names. You can also click in the Name column to change
the default target name. Optionally, select a color from the Color drop-down
menu.

Note: DigitalSuite™ Software automatically assigns the number of wells for the
target name.

4. Click Add to add dilutions. You can also click in the Dilution column to change
the default dilutions. Optionally, select a color from the Color drop-down menu.

5. Enter the dilution factor for the dilution.

In the duplex example study, TaqMan® Assay 1 has FAM™ dye as the reporter dye
while TagMan® Assay 2 has VIC® dye as the reporter dye.
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Analyze the study

The Samples/Targets screen of the duplex example study is shown in the following

image:
== Add | == Delete == Add = Delete | Diution Factor:
Name Color Comments # of Wells Dilution Fold Color
DNA Sample 1 hd 2,816 1 1i hd
NTC = A 256 0.1 10 &
0.01 100] N
1E-4 1E4]
o NTCi
0.5 2

Ll ]e]<]<

0.25 4
0.125 g
Manage Targets

b Add | -

Name Reporter Color Comments # of Wells
Tagman Assay 1 FAM v - v 3,072
Tagman Assay2 VIC V. v 3,072

Analyze the study

Once you have set up the plate, click Analyze. To modify the analysis settings, click
Analysis Settings.

The Analysis Settings dialog box for a duplex example study is shown in the following
image:

@ Analysis Settings

i" Configure this analysis setting for the study.

Flag Settings

General
Confidence Interval (%): Wel Volume (uL): |0.033

Sample Group-Specific Settings

Target Sample Auto? | Min Pos CRT | MaxPos C... | Min Neg CRT | Auto? | Low ROX Low Reporter
Tagman Assay 1 [DHA Sample 1 2000 35.1 36.1 402.88 331.42
Tagman Assay 1 [NTC 5 38 39 219.57 242.92
Tagman Assay2 [DHA Sampla 1 25.8 33.8 34.3 402.88 677.04
Tagman Assay2 [NTC 5 38 39 219.57 744.04

Reset to Defaults

OK and Analyze
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Analyze the study

View digital PCR Clicking on the Analysis button automatically takes you to the Digital PCR screen.
results Alternatively, click Digital PCR from the Results Workflow menu to access the screen.

The Confidence Interval value is displayed in the Title Bar of the Digital PCR screen.

Sample Group view

1. Click the Sample Group tab to view the sample group results.
For TagMan® Assay 1, the Copies/uL is 40.5.
For TagMan® Assay 2, the Copies/uL is 28.1.

2. For TagMan® Assay 1, view the lower confidence (38.1), upper confidence (42.9)
values, number of positive (1,168), negative (1,643), and undetermined (3) calls,
total number of positive and negative calls (2,811), number of omitted wells (0),
and number of empty wells (0).

3. For TagMan® Assay 1, for the Sample NTC the Copies/uL is NA. This is because
the number of positive calls for NTC is 0 and the DigitalSuite™ Software cannot
calculate the Copies/pL.

4. For TagMan® Assay 2, view the lower confidence (26.3), upper confidence (30.0)
values, number of positive (905), negative (1,908), and undetermined (1) calls,
total number of positive and negative calls (2,813), number of omitted wells (0),
and number of empty wells (0).

5. For TagMan® Assay 2, for the Sample NTC the Copies/uL is NA. This is because
the number of positive calls for NTC is 0 and the DigitalSuite"" Software cannot
calculate the Copies/uL.

6. View the corresponding plot in the lower half of the screen.

7. From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot
type displays the Sample Group on the x-axis and Copies/pL on the y-axis.

8. From the View drop-down menu, select Legend.

9. From the Color by: drop-down menu, select Target (default).
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Digital PCR - 95% Confidence Interval

Replicate Group

The Sample Group view for the duplex example study is shown in the following
image:

Copiesiul

45

40

35

30

25

20

# Target Sample Copies/uL Lower Conf Upper Conf [+] | @ # of Pos+Neg # of Omitted # of Empty
1  Tagman Assay 1 DNA Sample 1 40.5| 38.1 42.9| 1,168] 1,643 3 2,811 0| 2|
2  Tagman Assay 1 HTC /A N/A /A 0] 256| [t 256| 0| 0|
3  Tagman Assay2 DNA Sample 1 28.1] 26.3 30.0 905 1,908 1 2,813 0| 2|
4  Taqman Assay2 HTC IifA) I/ A /A 0| 256 0| 256 0] 0|
A
Sample Group Results
=% Plot: Linear Axis - ¥ view - w Color by: Target - /ﬁ) /f3 ‘:—f“ ihi,_,i ‘ifg] \g lE‘

Tagman Assay 1
DNA Sample 1

Tagman Assay?2
DNA Sample 1

Sample Group
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Replicate Group view

1.

Click the Replicate Group tab to view the sample group results.

For TagMan® Assay 1, having dilution 1, the Copies/uL is 40.5. The Copies/uL
should be roughly proportional to the dilution series. For example, dilution 0.5 is
half of dilution 1 then the Copies/uL for dilution 0.5 should be roughly half of that
for dilution 1. In the example study, the Copies/uL for dilution 0.5 is 20 which is
approximately half of 40.5.

For TagMan® Assay 2, having dilution 1, the Copies/uL is 29.7. The Copies/uL
should be roughly proportional to the dilution series. For example, dilution 0.5 is
half of dilution 1 then the Copies/uL for dilution 0.5 should be roughly half of that
for dilution 1. In the example study, the Copies/uL for dilution 0.5 is 13.1 which is
approximately half of 29.7.

Note: Life Technologies recommends you to check if the Copies/uL results are
always roughly proportional to the dilution series. If the ratio of Copies/
pL:dilution is significantly different in the Replicate Groups, check the plate setup
or re-run the experiment.

For TagMan® Assay 1, having dilution 1, view the lower confidence (36.6) and
upper confidence (44.1) values, number of positive (515), negative (186), and
undetermined (2) calls, total number of positive and negative calls (701), number
of omitted wells (0), and number of empty wells (1).
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Digital PCR - 95% Confidence Interval

Section 3.3  Analyzing Duplex Experiments
Run QC

3. For TagMan® Assay 2, having dilution 1, view the lower confidence (26.9) and
upper confidence (32.7) values, number of positive (439), negative (264), and
undetermined (0) calls, total number of positive and negative calls (703), number
of omitted wells (0), and number of empty wells (1).

4. View the corresponding plot in the lower half of the screen.

5. From the Plot drop-down menu, select Linear Axis (default). The Linear axis plot
type displays the Replicate Group on the x-axis and Copies/uL on the y-axis.

6. From the View drop-down menu, select Legend.
7. From the Color by: drop-down menu, select Target (default).

The Replicate Group view for the duplex example study is shown in the following
image:

# Target Sample Dilution Copies/uL Lower Conf Upper Conf [+] -] # of Pos+Neg # of Omitted # of Empty
1  Tagrman Assay 1 |DMA Sample 1 1 40.2] 36.6| za 515 186 2| 701 0 g
2  Tagman Assay 1 |DMA Sample 1 0.5 20.0) 18.0 22.3 340 363 0 703 0 kil
3 Tagman Assay 1 |DNA Sample 1 0.25 10.3] 8.99] 11.9] 203] 500] 1 703 0 0
4 Tagman Assay 1 |DNA Sample 1 0.125 5:15 4.27 6.21 110] 594 0 704 0 0
5 Tagman Assay 1 |NTC 0 YA N/A| NfA i 256 0 256| 0 [i
&  Tagman Assay2  |DNA Sample 1 1 29.7 26.9| 32.7 439 264 0] 703 0 il
7  Tagman Assay2 DMA Sample 1 0.5 13.1] 11.5 14.8] 246 457| 0 703 0 il
8  Tagman Assay2 DMA Sample 1 0.25 6.67| 5.64 7.87 139 565] 0 704 0 0
9  Tagman Assay2 DHA Sample 1 0.125 3.71 2.98] 4.61 81| 622 1 703 0 0
10 Tagman Assay2 NTC 0 /4| /4| I/ A 0 256 0 256 0 0

VA
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View - WColorby:Tangetv AP Ff; E“E 'EEQ] g E‘

Tagman Assay 1
DMNA Sample 1
1

Tagman Assay2
DMNA Sample 1
1

Replicate Group

Run QC

Heat Map

1. Go to Run QC » Heat Map to access the Heat Map screen.
2. In the Experiments view, select DuplexExample.eds.

3. View the corresponding Heat Map in the lower half of the screen.
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Run QC

Note: The VIC button appears enabled for duplex experiments. Click VIC to view
the Heat Map for VIC® dye.

4. Roll-over a sub-array. The tool-tip displays the well contents.

5. From the Show drop-down menu, select Flag to display flags in the heat map.
a. Look out for flagged wells or empty wells.

b. Check the location of these wells in the plate. If the location does not appear
to form any pattern, check the amplification curve in the amplification plot.
Based on these assessments, you can decide to manually change the call or
omit the well.

c. Click Analyze to re-analyze the study.

6. From the Color by: drop-down menu, select Call to display the wells by the color
of the Call.

7. Click Legend to show or hide the plate legend.
The Heat Map for the duplex example study is shown in the following image:

File Name
DuplexExample.eds

Barcode RO | o ‘ e | i | '
a0 [ o 3 g

Heat Map for: DuplexExample.eds

Amplification Plot

84

1. Go to Run QC » Amplification Plot to access the Amplification Plot screen.
2. In the Targets view, select TagMan® Assay 1.

3. View the corresponding Amplification Plot in the lower half of the screen.
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From the Plot drop-down menu, select AR vs Cycle (Linear) (default).

From the View drop-down menu, select Cry to display the Cgry icons on the plot.

From the Color by: drop-down menu, select Call to display the plot by the color

of the Call.

The Amplification Plot - Targets tab for TagMan® Assay 1 in the duplex example study

is shown in the following image:

Amplification Plot
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7. Perform step 2. through 6. to observe the Amplification Plot for the target

10.
11.

12.

TagMan® Assay 2.

In the Sample Group view, select TagMan® Assay 1.

View the corresponding Amplification Plot in the lower half of the screen.

From the Plot drop-down menu, select AR vs Cycle (Linear) (default).

From the View drop-down menu, select Cgt Range and Histogram to display the

Crr range and the Histogram on the plot.

From the Color by: drop-down menu, select Call to display the plot by the color

of the Call.
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The Amplification Plot - Sample Group tab for TagMan® Assay 1 in the duplex
example study is shown in the following image:

Amplification Plot
Target Replicate Group
# | R | Target Sample Copies/uL [+] -] Pos + Neg Omitted Empty e e e & &
1 Tagman Assay 1 [DMA Sample 1 405 1,168 1,643 3 2,811 0 2| 1] 1] 1/ Al 3 1/ Al
2 Tagman Assay 1 [NTC 1/ &l i 256| 0 256| 0 0 0 0 1/ &l 0 1/ &l
3 Tagman Assay? |DMA Sample 1 28.1 9os|  1,908| 1] 2,813 0 2 1 1/ &l 0 1/ &l 0
4 Tagman Assay2 |NTC 1/ &l 0 256| 0 256| 0 0 0 1/ &l 0 1/ &l 0
|=¥ plot ~ R View - y Color by: call ~ ol -l g ﬁ:ﬂ @g] \g E‘ i T View - EE== Group by - :I Bookmark - =,/ Change Cal -
< # Well| Ccall Call Type I Omit LEJ Empty Type
AR vs Cycle (Linear) e © [uto 0 A a
2,260 Ala2 @ |auto O Auto b
— Ala3 0 Auto [} Auto
Alad @ |auto [] Auto
1.750 Alas 0 Auto [} Auto
1,500 Ala6 @ |auto [] Auto
= Ala7 @ |auto [] Auto
E 1,250 Alag 0 Auto [} Auto
= 1om Albl @ |auto 4] Auto
2 Alb2 @ [Auto [&] Auto
= Alb3 @ |auto ] Auto
500 Alb4 @ |auto .4 Auto
- AlbS @ |auto [ Auto
Alb6 @ |auto [] Auto
e Alb7 | @ |Auto [ Auto
AlbB @ |auto [] Auto
Alcl @ |auto ] Auto
Al @ |auto [] Auto
= Alc: @ |auto ] Auto
Alct @ |auto [] Auto
% AlcS @ |auto ] Auto
g AlcE @ |auto [] Auto
g ke Alc? 0 Auto [} Auto
- Alcs @ |auto [] Auto
B Aldl @ |auto ] Auto
Ald2 @ |auto [] Auto
o
Ald3 € |auto ] Auto v
< >
For TagMan® Assay 1, DNA Sample 1, there are 3 undetermined wells when the study
is analyzed with the default analysis settings. You can review the amplification curve
for these three wells and after assessing the amplification curves, you can decide
whether you want to adjust the Cg range, manually change the call, or omit the well
altogether.
13. Perform step 8. through 12. to observe the Amplification Plot for the target
TagMan® Assay 2.
14. In the Replicate Group view, select TaqMan® Assay 1.
15. View the corresponding Amplification Plot in the lower half of the screen.
16. From the Plot drop-down menu, select AR vs Cycle (Linear) (default).
17. From the View drop-down menu, select Cgy to display the Cgr icons on the plot.
18. From the Color by: drop-down menu, select Call to display the plot by the color
of the Call.
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The Amplification Plot - Replicate Group tab for the duplex example study is shown in
the following image:

Amplification Plot
Target Sample Group
# N | Target Sample Dilution Copies/uL [+] [-] Pos + Neg Omitted | Empty bl s v & &
1 | |raomen ass... |pua sample 1 |1 40.2] 515| 186 2| 701 g 1 1 g /A 1 NJA| ~
2 Tagmen Ass... [DNA Sample 1 [0.5 20.0 340 363 0 703 g 1 0 1 /A [ /A
3 Tagman Ass... |DNA Sample 1 [0.25 10.3 203 500 1 703] q q 0 g /A 2 /A
4 Tagmen Ass... [DNA Sample 1 [0.125 5.15 110 504 q 704 q q 0 g /A q /A
5 Tagmen Ass... [NTC o /A q 256] q 256] q q 0 g /A g NA|
5 Tagman Ass... [DNA Sample 1 1 207 439 264 q 703 q 1 1 A 0 A 0
Tanman Ass NKA Samnle 1 0 5 131 4 a5 n i} n 1 ni MiA ni MiA ni bl
i
=¥ Plot - N e y Color by: call £ P ':-t: 'i\hi_l, [E) g IE‘ : % Vew- E Group by - jl Bookmark ~ =, Change Call -
AR Vs Cycle (Linear) # Well Call Call Type I Omit LEJ Empty Type
1 Alal & |auto [l Auto ~
2 Al & |auto ] Auto
3 Ala3 & |auto [i] Auto
4 Al @ |auto ] Auto
5 Alas & |auto [i] Auto
6 Alab & |auto ] Auto
7 A7 @ |auto [i] Auto
8 Alas & |auto ] Auto
9 Albl @ |auto [i] Auto
10 Alb2 @ |auto ] Auto
11 Alb3 @ |auto [i] Auto
& 12 Atb4 D |Auto ] Auto
2 iz abs @ Jauro ] Auto
= 14 Alb6 @ |Auto ] Auto
Ed 15 A7 @ |Auto ] Auto
16 Albg @ |auto ] Auto
17 Alcl & |auto [i] Auto
18 Al & |auto ] Auto
19 Alc3 & |auto [i] Auto
20 Al & |auto ] Auto
21 Al & |auto [i] Auto
22 Al & |auto ] Auto
22 Al & |auto [i] Auto
24 Al @ |auto ] Auto
25 Aldl & |auto [i] Auto
26 Ald2 @ |auto ] Auto
2 6 & 0 12 14 B 1B M 2 % X B W @ ¥ ® B @ |53 Ajd3 & |auto [ ] Auto v
Cyele < | >

Flag Summary

For TagMan® Assay 1, Dilution 1, there are 2 undetermined wells when the study is
analyzed with the default analysis settings. You can review the amplification curve for
these three wells and after assessing the amplification curves, you can decide whether

you

19.

want to adjust the Cgr range, manually change the call, or omit the well altogether.

Perform step 13. through 18. to observe the Amplification Plot for the target
TagMan® Assay 2 at other dilutions.

Tips for viewing the Amplification Plot for your own study

Sort the undetermined calls by clicking on the Call column header in the Well
Table so that you can select all the undetermined calls quickly and review the
respective amplification curves.

Sort the flagged wells by clicking on the & column header or the individual flag
column header in the Well Table so that you can select flagged wells quickly and
review their amplification curves.

After assessing the individual amplification curves, you can decide whether you
want to adjust the Crp range, manually change the call, or omit the well
altogether.

To view the updated results, you must re-analyze the study after making any of
the above changes.

Go to Run QC » Flag Summary to access the Flag Summary screen.

View the Flag Summary table.
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Flag
Low ROX

Icon
RQx

3. View the number of wells in which the flags Low ROX, Low FAM, Low VIC, Low

FAM Score, and Low VIC Score appear.

In the duplex example study, the Low ROX and Low FAM flags occur in one well
each, while the Low FAM Score flag occurs in three wells. To view the location of
the flagged wells, go to Run QC » Heat Map.

The flagged wells are displayed with a triangle in the well. For the example study,
the wells flagged with Low ROX and Low FAM are also empty wells. Therefore
the wells also contain a ‘x” along with the triangle.

The Flag Summary for the duplex example study is shown in the following image:

Description

The median of ROX signal (first 5 cycles) is lower than the threshold.

# of Wells # of Targets # of Sample Groups # of Replicate Groups

Low FAM

Fatn

The median of FAM signal (first 5 cycles) is lower than the threshold.

Low VIC

Low FAM Score

The FAM score is lower than the threshold.

Low VIC Score

[I|FT|

1]
1
The median of VIC signal (first 5 cycles) is lower than the threshold. 1]
3|
0|

The VIC score is lower than the threshold.

ol=|olm|n

2| 2|
1 1
0| 0|
1 2|
0| 0|

Export the Study

88

©® N o a M~ w b

. From the Export Workflow menu, click Export.

Select One file.

Select the Open after export check box.

Click Browse to select the directory and location to save the exported file.
Enter the file name DuplexExampleStudy_Export for the exported file.
Select .csv from the File Type drop-down menu.

Select the Results - Sample Group tab to export the Sample Group results.
Click Start Export.
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Export the Study

The Export screen for the duplex example study is shown in the following image:

Export Data To: (3) One File () Separate Files [] Export Bookmark Data only Open after export
Directory: |C:\App\|ed Biosystems\DigitalSuite Software\User Files File Name: | BN m| udy E. File Type:
m Results - Sample Group T Resuits - Replicate Group 1
Select Contents @y Previewing 15 of 6144 rows.
#
N # | wel | Target Sample Diution | Empty | Empty Type | Omit | Experiment Amp Score | Call Call Type | CRT Dye
Target 1|Alal |Tagman Assay 1 |DNA Sample 1 1|False Auto False |DuplexExample.eds | 1.3662527|Positive |Auto 30.1194115(FAM
Sample 2|alal |Tagman Assay2 [DNA Sample 1 1|False Auto False  [DuplexExample.eds 1.384751Positive  [Auto 29.7226753(VIC
i 3lata2 [Taqman Assay 1 [DNA Sample 1 iFake  |Auto False [DuplexExemple.eds| 1.3453406|Positive |Auto 20.8175488[FAM
Empty
4|Ala2 [Tagman Assay2 |DNA Sample 1 1{False Auto False  [DuplexExample.eds | 0.8050703|Negative |Auto Undetermined|VIC
Empty Type
omit 5|A1a3 |Tagman Assay 1 [DNA Sample 1 1|False Auto False |DuplexExample.eds | 1.3887613|Positive |Auto 29.818224{FAM
Experiment 6|A1a3 |Taqman Assay2 [DNA Sample 1 1[Fake  |Auto False |DuplexExample.eds | 1.3937447|Positive |Auto 28.8170757|VIC
Amp Score
al 1a4 [Tagman Assay 1 [DNA Sample 1 1|Fakse Auto Fale |DuplexExample.eds 0.0|Negative [Auto undetermined|FAM
call Type 8|A1a4 |Tagman Assay2 |DNA Sample 1 1|False Auto False  [DuplexExample.eds 1.355303Positive  [Auto 29.9600315(VIC
CGRT 9|A1a5 |Taqman Assay 1 [DNA Sample 1 1{False Auto False  [DuplexExample.eds 1.36269|Positive  [Auto 20.2201385|FAM
Dye
10/A1a5 |Tagman Assay2 |DNA Sample 1 1|False Auto False |DuplexExample.eds | 1.3872343|Positive |Auto 28.6707058{VIC
11|A136 |Tagman Assay 1 |[DNA Sample 1 1|False Auto False |DuplexExample.eds | 1.3895538|Positive |Auto 30.2500725|FAM
12|A1a6 |Tagman Assay2 |DNA Sample 1 1|False Auto False |DuplexExample.eds | 1.3890629|Positive |Auto 29.7632923(VIC
13|A1a7 |Tagman Assay 1 |DNA Sample 1 1|False Auto Falke |DuplexExample.eds 0.0[Negative [Auto undetermined|FAM
14|A1a7 |Tagman Assay2 |DNA Sample 1 1|False Auto False  [DuplexExample.eds 1.3492163Positive  [Auto 28.9324512{VIC
15/A1a8 |Tagman Assay 1 [DNA Sample 1 1{False Auto False  [DuplexExample.eds | 1.3166798|Positive |Auto 30.8118877[FAM
<
( 0ty + ampleStudy_Export.csv - - =%
~ Home | Inset  Pagelajout  Formulas  Data  Review  View  AddIns  Acobat @ - o x
MBS . cut, = = = g || EE | E AutoSum -
Calibri [ - [l | | SiwmapTed General - ﬂ ﬁ | T ﬁ
Pyt L 7R B S #
Paste T e | P Merge & Center - || $ - % #||<@ 52| Conditional Format Cell || Insert Delete Format Sort & Find &
- Format Painter || & EElasim || 8 28] Formatting - as Table * Styles = - - | & dear~ e Select~
Clipboard ] Font ] Alignment iz Humber ] Styles Cells Editing
[ Al ~ (- fi | #Study Name: D ExampleStudy
A 8 c D e | F | & [ H 1 K L M N o B
1 |#Study Name: D ExampleStudy
2 |#Description: Duplex example study
3 #Comments:
4 |#Date/Time Study Modified: 02-07-2012 10:02:40 SGT
5 |#Confidence Level: 0.95
6 |#Wwell volume (ul): 0.033
7 #sample Group-Specific Settings
8 l# Target  Sample Min Pos C Max Pos CMin Neg € Low ROX  Low Reporter
2 1 Tagman A DNA Samp 27.09933 35.09933 36.09933 402.88 331.42
10 2 Tagman A NTC 5 38 39 219.5735 242.9201
11 3 Tagman A DNA Samp 25.83194 33.83194 34.83194 402.8824 677.0441
12 4 Tagman A NTC 5 38 39 219.5735 744.0401
13
14
15 & well Target  Sample Dilution Empty  Empty Typ Omit Experimal Amp Score Call Call Type CRT Dye
16 1Alal Tagman A DNA Samg 1 FALSE Auto FALSE DuplexExi 1.366253 Positive Auto 30.11941 FAM
8 %5 2 Alal Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.384751 Positive Auto 29.72268 VIC
18 3 Ala2 Tagman A DNA Samp 1 FALSE Auto FALSE DuplexEx: 1.345341 Positive Auto 29.81755 FAM
19 4 Ala2 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 0.80507 Negative Auto Undeterm VIC
20 5 Ala3 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexExi 1.388761 Positive Auto 29.81822 FAM
N 6 Ala3 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.393745 Positive Auto 28.81708 VIC
22 7 Alad Tagman A DNA Samp 1 FALSE Auto FALSE  DuplexEx: 0 Negative Auto Undeterm FAM
23 8 Alad Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.355303 Positive Auto 29.96003 VIC
24 9 Alas Tagman A DNA Samg 1 FALSE Auto FALSE DuplexExi 1.36269 Positive Auto 29.22014 FAM
25 10 Alas Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.387234 Positive Auto 28.67071 VIC
26 11 Ala6 Tagman A DNA Samp 1 FALSE Auto FALSE DuplexEx: 1.388554 Positive Auto 30.25007 FAM
27 12 Ala6 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.389063 Positive Auto 29.76329 VIC
28 13 Ala7 Tagman A DNA Samg 1 FALSE Auto FALSE  DuplexEx: 0 Negative Auto undeterm FAM
29 14 Ala7 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.349216 Positive Auto 28.93245 VIC
30 15 Alag Tagman A DNA Samp 1 FALSE Auto FALSE DuplexEx: 1.31668 Positive Auto 30.81189 FAM
31 16 Alag Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 0.918463 Negative Auto Undeterm VIC
32 17 Albl Tagman A DNA Samg 1 FALSE Auto FALSE DuplexExi 1.327878 Positive Auto 31.11838 FAM
33 18 Albl Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 0.585863 Negative Auto Undeterm VIC
34 19 Alb2 Tagman A DNA Samp 1 FALSE Auto FALSE DuplexEx:  1.3909 Positive Auto 31.10364 FAM
35 20 Alb2  Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.392364 Positive Auto 29.87334 VIC
36 21 Alb3 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexExi 1.396748 Positive Auto 30.39477 FAM
37 22 A1b3 Tagman A DNA Samg 1 FALSE Auto FALSE DuplexEx: 1.388762 Positive Auto 29.59573 VIC
38 23 Alb4 Tagman A DNA Samp 1 FALSE Auto FALSE DuplexEx: 1.347526 Positive Auto 30.31981 FAM
R4 b b Duplexty = Export <% e T ) 77- — — I
Ready |
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Ordering Information

Note: A QuantStudio™ OpenArray® Accessories Kit, Part no. 4469576, is included with 10-pack
array orders.

QuantStudio™ Digital PCR Kits

Item Part number Storage Conditions
QuantStudio™ Digital PCR Kit (10 Pack) 4470184 Upon receipt, store the frozen,
QuantStudio™ Digital PCR Kit (4 Pack) 4470185 unopened plates at -20°C.
Description of
components
Item Part number Description
QuantStudio™ Digital PCR Plates 4470196 (4 Plates) 4 plates or 10 plates, depending on the
4470197 (10 Plates) | °"der
2X TagMan® OpenArray® Digital PCR Master Mix 4458086 (1.5 mL) 1.5 mL or 5 mL, depending on the order
4458080 (5 mL)
QuantStudio™ OpenArray® Accessories Kit 4469576 1 kit, enough for 10 arrays
(not included with Part no. 4470185)
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Documentation and Support

Related documentation

The following related documents are shipped with the system:

Part

Document
number

Description

Applied Biosystems QuantStudio™ 12K 4470689 Describes the QuantStudio™ 12K Flex System hardware and

Flex Real-Time PCR System software and provides information on preparing, maintaining, and
Maintenance and Administration Guide troubleshooting the system.

Applied Biosystems QuantStudio™ 12K 4470935 Provides brief, step-by-step procedures for performing experiments
Flex Real-Time PCR System: using the OpenArray® sample block on the QuantStudio™ 12K Flex
OpenArray® Experiments User Guide System. It is designed to help you quickly learn to use the

QuantStudio™ 12K Flex System.
Applied Biosystems QuantStudio™ 12K " 4470050  Provides brief, step-by-step procedures for performing experiments

Flex Real-Time PCR System: Multi- using the 384-well, 96-well, Fast 96-well plates, and Array Card
Well Plates and Array Card sample blocks on the QuantStudio™ 12K Flex System. It is designed
Experiments User Guide to help you quickly learn to use the QuantStudio™ 12K Flex System.
Applied Biosystems QuantStudio™ 12K 4470695 Describes the QuantStudio™ 12K Flex System software and

Flex Real-Time PCR System Help provides procedures for common tasks.

Portable document format (PDF) versions of the above guides are available at:
www.lifetechnologies.com/quantstudio.

Note: To open the user documentation, use the Adobe® Reader® software available
from www.adobe.com.

Note: For additional documentation or if you cannot access the user documentation,
see “Obtaining support” on page 97.

Obtaining SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/sds

Obtaining support

For service and technical support, call toll-free in US: 1.800.955.6288, or contact your
local Life Technologies representative.

For the latest services and support information for all locations, go to:

www.lifetechnologies.com/support
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Documentation and Support
Limited Product Warranty

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
¢ Submit a question directly to Technical Support

® Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

¢ Download software updates and patches

Limited Product Warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies” General Terms and Conditions of Sale found on Life

Technologies’ website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/support.
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amplification curve

amp score

baselined data

blank well

confidence interval

Crt

dilution

empty well
flagged well

negative well

omitted well

Poisson distribution

positive well

Glossary

General term for time series data of PCR fluorescence vs. cycle number; amplification
curves are often normalized by a passive reference and usually referred to as Rn vs.
Cycle data. Curves that have been baseline compensated (see baselined data) are
typically referred to as Rn vs. Cycle data.

A value that reflects the level of amplification in a well. In general, a low value
indicates lesser amplification in that well.

Amplification curves where the baseline has been removed by either subtraction or
division of a line computed by a linear regression through the baseline region.

Wells in the sub-array that do not contain any setup information.

The Confidence Interval is used to calculate the lower and upper confidence values in
the Digital PCR screen. For example, for a Confidence Interval value of 95%, the actual
possibility of copies/uL falling between the lower and upper confidence values is 95%.

Result obtained on applying the Relative Threshold algorithm on the amplification
curve. The Relative Threshold algorithm is a well-based analysis based on the PCR
reaction efficiency and fitted to the Amplification curve. This setting is ideal for a
single sample across genes with no dependence on targets, thereby reducing
variability.

The concentration of diluted sample in a well with a value of 0.0 ~ 1.0 normalized
against the original concentration of the sample.

Empty wells are those that are flagged with Low ROX, Low FAM, or Low VIC flags.
Wells containing one or more flags.

Wells with negative calls. Negative calls mean the DigitalSuite"" Software determines
that a well does not contain any copy of the sample.

Wells manually omitted by a user

In probability theory and statistics, the Poisson distribution (or Poisson law of small
numbers) is a discrete probability distribution that expresses the probability of a given
number of events occurring in a fixed interval of time and/or space if these events
occur with a known average rate and independently of the time since the last event.

Wells with positive calls. Positive calls mean the DigitalSuite Software determines
that a well contains at least one copy of the sample.
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Glossary

replicate group
replicate
sample group

undetermined well

well

96

A group of replicates that share the same sample, target and dilution.
A combination of one sample and one target in a well.
A group of replicates that share the same sample and target.

A well is undetermined when a user:

¢ Cannot tell if a well is amplified or not.
* Sees a spurious signal called with a Cy value.

* Does not want to include low efficiency wells in calculations.

A well in a conventional plate, or a through hole in an OpenArray plate.
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384-well sample plate 10

A

amplification plot 40
amplification plot, viewing 40
analysis settings 31
digital PCR settings 31
flag settings 31
analysis workflow, general 21
analyzing
duplex experiments 79
singleplex experiments 65
assign 25

B
bookmark 37, 40, 41, 44, 45, 53, 54, 58

C

call
negative 31
positive 31
undetermined 31
color by 26

D

digital PCR
about 9
components 9
digital PCR experiments
about 10
setup 11
workflow 12
digital PCR plate 10
DigitalSuite™ Software
analysis workflow 14
features 13
dilutions, managing 29
documentation, related 97

F
flag settings
low FAM score 31
low VIC score 31
flag summary 59

G

genotyping plate
storage conditions 16

H

heat map 37
experiments 37
heat map for 38

heat map, viewing 37

L
legend 27

M

manage dilutions 29
manage samples 28
manage targets 29

0

Ordering 95
Ordering Information 95

P

perform QC
amplification plot 40
flag summary 59
heat map 37
plate layout
storage conditions 16
plate layout, setting up 25
plate setup
manage experiments 25
plate setup for
(study name) 25
prepare the sample plate
required materials 16

Q

QC, performing 37
QuantStudio OpenArray plate
experiment plate 9
sample plate 9
QuantStudio™ Digital PCR Plate
analyze data 18
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Index

prepare 16
procedure 17
run 17
QuantStudio™ OpenArray® plate 9

R

required materials
prepare the sample plate 16
storage conditions 16
results, viewing 32

S

Safety Data Sheets (SDSs), obtaining 97
sample plate
prepare 15
required materials 16
samples and targerts, setting up 28
samples, managing 28
setting up samples and targets
manage dilutions 29
manage samples 28
manage targets 29
show 26
storage conditions 16
study properties, defining 23
study, analyzing 31
study, creating 22
support, obtaining 97

T

targets, managing 29
training, information on 98

\

view results
replicate group tab 34
sample group tab 32
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